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Introduction

Introduction

Welcome to TheBrain™, your ultimate digital memory and no limits mind mapping
software. Intelligence comes from the mind’s ability to think associatively—that is,
to leap from thought to thought, building webs of greater and greater complexity,
until new ideas are built. Associations are our inspirations. TheBrain allows you to
organize your information in the same way, without limiting you to a pre-
determined file structure. In fact, with your digital brain there are no limits. You can
create a small project-focused brain or grow your brain to hundreds of thousands
of thoughts!

Now you don't have to force any idea or project into a single folder. TheBrain
organizes information as thoughts. Unlike folder directories and search lists, a
“thought” in your brain can have many connections and contexts. Moreover,
TheBrain displays your thoughts by concept or project, linked according to how
you think. Now you can get the big picture and discover information that might
otherwise be overlooked.

Thoughts contain relevant notes, web pages, and files. Brains can be synced for
easy access from your desktop to TheBrain Cloud or your mobile devices.

®2» fie Edit Thought View Options Onine Window Help - o
e Sharpe | My Brain
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Notes to self
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- My B. I’aIEJ [ Check out the new sandwich shop next to work
= [ Start my new car research
O Electic
O Used

¢ ® . 0 Room for my drum kit
J Go.als 4 Personal Life 1 Smile at strangers!

I'm Most:lnt-erested In... o“ What I'm TthkEngEAbout Now
*.g My \i\lor(l;
My Brain
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1 Mv Work

! S
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Figure 1. TheBrain Interface

Thoughts are Information

TheBrain thoughts can represent just about any type of information, including
concepts, people, documents, spreadsheets, images, videos, shortcuts, and web
pages. By letting you create links and associations between thoughts, TheBrain
expands to become a visual interface that reflects the way you think.
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Using simple click-and-drag techniques, you’ll be able to create and navigate
through networks of thoughts in a conceptual space unique to your work habits.
When you begin using TheBrain, you will find that your computer becomes easier
to use—faster, more enjoyable, and less frustrating—helping you use your time
more efficiently.

TheBrain’s Dynamic Graphical Interface

TheBrain lets you create a simple, dynamic graphical map in which to input and
navigate all your information. Your brain starts with a single thought, to which
several other thoughts can be visually linked. These thoughts have their own
links to other thoughts and, possibly, to each other. TheBrain’s flexible structure
allows any thought to be linked to any other thought, so you are never more than
a few steps away from the information you are seeking. It's simple to make
connections between thoughts so that they reflect the connections you make in

your mind.

Cross Platform Accessibility

Brain data is accessible from virtually any device with rich full-featured clients on
Windows and macOS plus mobile clients for iOS and Android. Additionally, you
can access your brain via a web browser by logging in at www.thebrain.com.
TheBrain’s sync service keeps all your data backed up and synchronized over
the cloud for seamless access.

This user guide is focused on the Windows and macOS software. Please visit
www.thebrain.com for information about the mobile clients.

About this Guide

The following icons are used throughout this guide to flag categories of
information:

) This icon is used to identify notes.

’ This icon is used to flag tips and suggestions.

TheBrain is offered in two editions—Free and Pro. Icons are used throughout the
guide to flag features that are specific to the Pro edition. Features that are
available in both editions are not designated with a special icon.

IP[}’@ This icon is used to indicate that the feature is available in the Pro edition only.
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Because TheBrain works on Windows and macOS, OS-specific features are
flagged with icons throughout the guide. Features that are available for both
Operating Systems are not designated with a special icon.

#_  This icon is used to indicate that the information applies only to computers

' running macOS.

gl Thisicon is used to indicate that the information applies only to computers
M running Windows.

In addition:

Labels Names of buttons, menus, commands, keys, and icons appear in this font
throughout the guide in order to stand out.

Note to macOS Users

#_  Right-clicking: Most features in TheBrain can be accessed with just a single

' click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-
clicking. On a Macintosh, many systems do not have a right mouse button. For
trackpad users, click or tap with two fingers. Alternatively, hold down the
Control key while you click. Note that many mice can be set up to interpret
clicks on each side of the main button differently so that Control-clicking is not
necessary. To enable this, alter the Mouse settings in the System Preferences
area of your Mac. Select “Secondary Button” for the right side of the mouse.

Ctrl key: Some features are accessed by clicking while holding down the Ctrl
key on Windows. For macOS, use the Command key.

TheBrain 13 supports Native Apple Silicon.

Here is a list of working definitions for the basic terms used throughout TheBrain.

Brain A collection of associated thoughts, each of which can have
content. You can create multiple brains.

Thought The topics that you link together in your brain are called
thoughts and are the basic unit of a brain. A thought can
represent anything you want it to. It can include an icon, notes,
and one or more attachments (such as files and web sites) or it
can have no content at all and simply act as a subject heading
or organizer. Minimally, a thought has a name.
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Plex The visible, graphical portion of your brain that displays your
thoughts.

Content Area  The portion of TheBrain window that displays content that can
be associated with the active thought or link. Types of content
include notes, attachments (such as worksheets, presentations,
documents, videos, and images), links, URLSs, and events. The
content area also displays and provides quick access to related
thoughts.

, Clicking any thought or link in the plex displays its associated content in the
. content area.

CSSSADF A -0
3

Plex . Content
< My Brain Area

Notes to self

Il )

B
& [Cinsert |@
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il [V PRTY L
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What I'm Th. & New York__Lee Sharpe

Figure 2. TheBrain Plex and Content Area

Active The active thought appears in the center of the plex and is
Thought the current focus. Any items attached to the thought, like
notes, files, links, and events appear in the content area.
~ . E
Athought—"* aMy Work
Circle and
~ border

Same thought

when active/{ B NTy \iVork]"

Same thought with
mouseover, but not active =
(border, but no circle)

.

Figure 3. The Different Ways a Thought Can Appear
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As shown below, when you click a thought, it moves to the center of the plex and
it becomes the active thought.

:jPer.scr:al Life. @ Goals @ Hobbies
b8 Jane's Brain
. @"Goals ‘o h71yWork Clickinga
o@@I'm Most Interested In 4 Personal Life thought ...
+ My Latest.Prgoccupations >~ What I'm Thinking Abdut Now
gaPersonal Life @ Goals @ Hobbies
o Jane's Brain
<> i .
@ Goals
o@pI'm Most Intereste...
4, Personal Life ¢ My La:est. Preocc...
acti\{ate§ ol r31yw°rk
it, moving it_ What Pm Thinkin...
to the center N ‘
of the Plex ’ T:amily o+ Home Projects
‘@;Food o&k My. Passions
- Friends 'r'-,«‘Fv1 Pet
Y,
ok Health and Fitness o83 Personal Finance
« @ Hobbies '
2 <
< > « Friends % Healtha.. FHomePr.. My Passi.. " MyPet & Personal.. MHobbies §jJane’sBr.. g Personal..
Figure 4. Activating a Thought
Thought A thought is said to be a “parent thought,” “child thought,”

Relationships “sibling thought,” or “jump thought” based on its relationship
to other thoughts with which it is linked.

In your own life, you may be someone’s parent, and
someone’s child, and someone’s sibling, and someone’s
peer, advisor, or colleague. So, who are you? The answer to
that question is relative—it depends on the circumstances
and what hat you're wearing at the moment.
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4 , A
You may be ... g

a child of

a parent j
\~—a sibling

a colleague

a parent
of a child

N

Figure 5. Relationships are Relative to You

The same applies to thoughts. The relationships between
thoughts are displayed automatically, based on which thought
is active at the moment.

Whether a thought is a parent, child, or sibling depends on its

. current relationship to the active thought.
/') File Edit Thought View Options Online Window Help - o X
= Lee Sharpe | Hobbies 5:.' n
CARS AwmA A @ =0 (]
=My Brain _2Hobbies Marketing
Parent Thought o
\ Sibling Thoughts
o2 Pergorlal Life "’VF g /
- 3= o £ Family and Friends
Active Thought e A
— » * Food
= - e ® 3
N — 94 Health arld Ftl:tness
/‘Budgeto £ Hobbies 5% Home Projects
: A . e
Jump Thought - — - Y Pers:o.nal.Fmance
e : R of, Travel
o ) ' 9 * B
o'a'Art and Culture o & Sp<.>rts
o# Ga.rdening Teghnplogy
cﬁ‘Ma{sic o[71What I'n: Rgading Now

orw Snorkeli‘ng‘ and Diving

Child Thoughts

< > New Ideas What I'm Th... @New York Lee Sharpe . gMyWork My Brain 4 Personal Life miBudget @My Passion @& 'Sports Hobbies
\ /

Figure 6. Thought Relationships are Relative to the Active Thought

Child Child thoughts are subtopics of the active thought. They

Thought appear in the “child zone,” below the active thought. In the
picture above, the active thought “Hobbies” has seven child
thoughts.
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Parent Parent thoughts represent superordinate topics of the active

Thought thought. They appear in the parent zone, above the active
thought.

Sibling Sibling thoughts share a parent with the active thought. They

Thought appear in the sibling zone, to the right of the active thought.

In the picture above, “Family,” “Food,” “Health and Fitness,”
“‘Home Projects,” “My Passion,” “My Pet,” and “Personal
Finance” are siblings of “Hobbies” because they are all
children of “Personal Life.” Sibling thoughts will not be
displayed if there are more than 50 parents to show in the
current plex.

Jump Jump thoughts are related to the active thought but are

Thought neither child nor parent topics. They appear in the jump zone
to the left of the active thought. Jump thoughts have an
“equal weight” relationship with the thought to which they are
related. For example, as shown above, “Hobbies” has the
various hobbies “Art and Culture,” “Gardening,” “Music,”
“Snorkeling and Diving,” “Sports,” “Technology,” and “What
I’'m Reading Now” linked as child thoughts since they are
types of hobbies. “Budget” affects the amount of resources
available to spend on the various hobbies and so it is closely
related, but it is not a hobby itself. Therefore, it makes a
perfect jump thought—related, but not part of the main
thought grouping.

Gate Thoughts in the plex have three circular “gates,” each of
which is used to link a specific type of relation: The parent
gate is above a thought, the child gate is below it, and the
jump gate is to the left or right of it. A gate is hollow when
there are no links attached to it and solid when one or more
links are attached. Solid gates in a contrasting color have
links to thoughts that are not currently showing in the plex.
The color of gates is based on the current color scheme.
When you point at a gate, a highlighting circle appears
around it.

Link A link is the line that connects two thoughts. When used as a
verb, to “link” is the act of connecting thoughts to establish
close relationships. Links can also show direction to help you
visualize relationships.
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Figure 7. Thought Gates

Installing TheBrain and Creating a Brain Account
The first time you download and install TheBrain, you’ll be prompted to log in or

create an account if you don’t already have one. The log-in window provides the
ability to create a new account or log in to an existing account.

@ X |

T H&E
® P SRAIN

[ Login ]

Forgot Password

Create Account

TheBrain Cloud (https://api.thebrain.com

Figure 8. TheBrain Log-in Window

Here are the fields to complete if you're creating a new account:
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® T HE&E
®
BRAIN
Your first name

' /Your last name

L Email address to
&4 be associated with

Ausefmame [ this account
you create
(no spaces —V A password
and at least 2 4 You create
characters)

v—w Confirmation of
= your password

Newsletter [ | Interested in TeamBrain

| Create Account |

Login

TheBrain Cloud (https://api.thebrain.com/)

Figure 9. Creating a New Account

After you click the Create Account button, TheBrain will send an email to the
address you specified.

, Check for a message from no-reply@thebrain.com. Make sure to check your
- spam folder if you don’t receive the message promptly.

When you open the message, you will see a green Activate Brain Account link.
After you click the link, you’ll see a notice confirming your success.

TheBrain 13 User Guide 9



Introduction

THE&E
S BRAIN'

Your Brain account is almost ready!

To activate your account, click the button below.

Activate Brain Account

For more resources on getting started with your BraX, visit our online support center.

Enjoy! *
THE
BRAIN

TheBrain Team .

Questions? Call us at

el | Activation Successful: LeeSharpe67@gmail.com

Thanks for verifying your email address. Your account has been activated.
Return to TheBrain application to login.

TheBrain Technologies LP, 11522 W Washington Blvd, Los Angeles, CA 90066

Figure 10. Activating a New Account

Now you can return to TheBrain and log in.

3 file Edit Options Window Help
[=] Brains
©+ | C |az .
% Gl Edit Thought View Options Orline Window Help
= Me | Welcome ta TheBrain
AR PmA A e

Me

Welcol

© Welcome to TheBrain
e
g
e Welcome to TheBrain
Welcome to TheBrain Wie've added a bit of content to help get you started Please
{@Welcome to Thehrain) e e Tt 3 e Ao

TheBrain helps you

letting you connect "2 TR
you can organize, ¢
elements of your di

b
>

Ve @wecome o e ]

Need help getting started?,

Create a Quick-Start Brain

Looking for your brains?

Login

Figure 11. Welcome to TheBrain
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Click “Create a Quick-Start Brain” and follow the directions on the screen to enter a
personalized name for this brain. The Quick-Start brain is actually a dynamic
resource for learning more about using your brains and you'll find a wealth of
useful information in it. Click any of the links to see what is displayed.

v

You can always create a hew Quick-Start brain by selecting the Create a Quick-
Start Brain command on TheBrain Help menu.

Opening Older Brains

When you’re looking at old and new brain files, note that brains created in
TheBrain 7 or 8 have filename extensions of .brain. Brains created in some earlier
versions have a .brn filename extension.

To open a .brn file that you created in a version older than TheBrain 8, first
open it using TheBrain 8 and then import the resulting brain in TheBrain 13, as
described in the steps below.

3

Any older Brain must be opened in TheBrain version 8.0.2.2 before it can be
imported into TheBrain 13. Version 8.0.2.2 can still be downloaded and
installed. Please contact support@thebrain.com for a v8.0.2.2 download link.

3

To open a brain that you created in TheBrain 8:
1. Open TheBrain.

2. Click the File menu, then click the Import command.

.'/ All dialog boxes can also be navigated via the Tab and Arrow keys.
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=2 Import X

(® Create a new brain

(O Add to "Lee Sharpe" and link to "Hobbies"

Brain Archive (.brz) TheBrain 8 Brain
Text Outline (:txt) All of the data from your Brain will be
imported into this version of TheBrain.
Your existing version 8 Brain will not be
TheBrain 8 XML (.xml) changed and will remain available.

Note that any changes you make cannot be
migrated backward to version 8.

Folders

TheBrain 8 Brain (.brainzip) S

MindManager (.mma
ger { ) To impeort data from earlier versions of

FreeMind (.mm) TheBrain, open it using TheBrain 8 first then
import the resulting Brain here.

| Select File... || Cancel |

Figure 12. Import Box for Opening an Older Brain

3. Click the Select File button, navigate to the brain of your choice, then click
the Open button when the file is selected. You will see a running progress
report.

4. When TheBrain has finished converting, you will see a “Conversion
complete” message as shown below. Click the Import button.

Source: |asdf.brain

Import | | Cancel

Figure 13. Import Conversion Progress

5. When TheBrain has finished importing, you will see the following dialog
box. Click the Open button to open the brain you just imported in a new tab
of TheBrain window.
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3 Import Complete X

Do you want to open the imported brain?

l Open H Cancel I

Figure 14. Open the Imported Brain in a New Tab

Suggestions for Transitioning to Your New Brain

Here are some tips for establishing a happy relationship with your brain:

)

You may want to attend one of TheBrain’s free online seminars on getting
started—TheBrain 101. To learn more about TheBrain 101, go to
http://www.thebrain.com/101.

Avoid “converting” to a Brain-only environment all at once. Make the transition on
a file-by-file basis so that every piece of information your brain contains will be
useful.

Build your brain as you go—associating thoughts as they occur naturally.

Avoid the temptation to move large folders into your brain. TheBrain can handle
this, but your brain will be cluttered with thoughts you may not need.

Remember that your first brain doesn’t need to be your only brain or your last
brain. Experiment! Create a brain just for fun, to try out the possibilities—give
yourself room to stretch and explore. Your brain is waiting!

Questions? Contact TheBrain Support Team right from within TheBrain app by
choosing Contact Us from the Help menu in TheBrain toolbar.
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Understanding Thought Relationships

There are no rules governing the relationships between thoughts—whatever
makes sense to you is the way your brain ought to be organized. The three
primary relationship types—child, parent, and jump—can be used to express
different types of relationships. Sibling is a relationship that is derived from
child/parent relationships.

The examples in this section can help you understand the variety of relationships
and how they are used. The core concepts behind each type of relationship are
as follows:

= Children: Child thoughts are usually used to link more specific information or
information that represents a sub-category.

= Parents: Thoughts linked as Parents are usually used to link more general
information. Parents can also be thought of as higher-level categories to
classify groups of information. They serve to indirectly connect their child
thoughts as siblings.

=  Jumps: Jump thoughts are usually used to link two pieces of information that
are exclusively related, meaning that the two items are related to each other
but neither represents a group that the other is a part of.

Let's move on to an example to explore these relationship types. Imagine that
you are the owner of a company and you are reviewing personnel files. Each
employee has a file. You decide it makes sense to organize your employees by
department. Your brain is called My Brain. From My Brain, you create a child
thought called My Company (see Figure 15). My Brain is now My Company’s
parent thought. You create four child thoughts from My Company—
Manufacturing, Sales, Service, and Billing. These departments are sibling
thoughts of each other.
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p S

') File Edit Thought View Options Online Window Help = O X
A -
=My Brain | My Company ’ b
CARDS 2m A A+éd- L o
O .
oMy Brain
)
¢ My Company
@ .
oBilling oSales
& 9= .
oManufacOturmg oSeerce
<
4 > My Brain  Billing Manufacturing Sales Service My Company

Figure 15. Sample Brain

Now you go to each department and create more child thoughts, one for each
employee of the department. If an employee splits time between two
departments, you can make him a child thought of both departments—he’ll
appear in both and you won'’t have to duplicate his thought. In this example, Bob
is a child thought of both Manufacturing and Sales (see Figure 16). This is one of
the most powerful features of TheBrain—having one thought under more than
one heading.

= My Brain | Bob ."a"
AR A& A A d =N B 0

oManu.fac.turing oS’aIe.s

{Bob)

Figure 16. Child Thought with Two Parents
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If you own more than one company, but have one accountant for all of them, you
might want to create a thought called Accountant and link it as a jump thought to
each company, as shown below.

—IMy Brain | Accountant

CARD 25 A A d (N |
o .
oBI”Irlg
My C.ompany-
@
My Other Companye

Figure 17. Jump Thoughts to the Active Thought

Imagine that Joe’s company has just purchased one of your companies. Since
Joe’s company now owns this company, Joe’s Company becomes a parent (see

below).

TheBrain 13 User Guide

®> File Edit Thought View Options Online Window Help = o X
== My Brain | My Other Company E.' n
CARDY AmA| A @ =0 ©
oJoe’s Company oMy Brain
° A d )
Accountante {My Other Cpmpany} *My Company

4

Sales Service MyCompany Bob Manufacturing Billing Accountant Joe's Company My Other Co...

Figure 18. New Parent Thought
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Understanding Thought Relationships

Because Joe wants to avoid a conflict of interest, the acquired company (My
Other Company) no longer uses the same accountant. So its jump gate is hollow,
while its sibling’s jump gate (My Company) maintains that link and is filled.

As you use TheBrain, you will develop a sense of the types of relationships you
wish to make between thoughts. It is always easy to change relationships by
adding and removing links (see Changing Relationships Using Drag and Drop on
page 103).

Families of Thoughts

It is tempting to view thought relationships as families, and indeed these different
parts of your brain are types of families, with their ancestry visually spread before
you, represented by subjects and categories. But unlike human families, a child
thought can be a parent of one of its siblings and a thought can have more than
two parents.

The complex relationships you can form in TheBrain are the source of its power.
Let’s consider sibling thoughts that also share a parent/child relationship.

Let’s say you are studying philosophy. You might have a thought called
Philosophy. Individual philosophers such as Plato and Aristotle could be child
thoughts of Philosophy. Each of these siblings, in turn, may have child thoughts.
Aristotle was a student of Plato, so you may want to make Aristotle not only a
child of Philosophy, but of Plato, so that when you’re working with Aristotle, Plato
is only a thought away.

®» file Edit Thought View Options Online Window Help - o x
=
My Brain | Aristotle E'n
CARS 2w A A+ @ e 0§ 0
<O
oPhilosophy oPlato
oAristotle oTheories

oDialogues Q Meamngoof Life

4

< » The Plato Meaningof L.. Philosophy Greek Roman Parthanon Pantheon Dialogues Aristotle

Figure 19. Example of Parent/Child Relationships
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Notice that when Philosophy and Plato are in Aristotle’s parent zone, their
relationship (Philosophy is a parent thought of Plato) is shown by the line linking
the child gate of Philosophy to the parent gate of Plato.

Clearly, TheBrain is a powerful method of organizing ideas and information. No
hierarchical file structure can provide as much cross-referenced information at a
glance. And our example is pretty basic—a fully developed brain can hold many
more relationships and much more information.
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Navigating Your Brain

All thoughts can be connected—directly or indirectly—even thoughts that may
seem to have nothing to do with each other can be related through a chain of
links.

Let’s look at an example, say, the Queen of England and asparagus. You have a
thought called Queen of England. One of its child thoughts is Prince of Wales,
which has a parent thought—Famous Princes—that is also linked to the story of
the Frog Prince.

oFamous Princes éQueen of England

==

Prince of Wales oFrog Prince

The story has another parent thought called Fairy Tales. A sibling of Frog Prince
is Jack and the Beanstalk.

OFalry Tales oFamous Prmces

¢Jack and tﬁe Beanstock
oLittle Red Rndmg hood
95 ﬂMother Goose

o Prmce of Wales

Jack and the Beanstalk has child thoughts called Giant and Jack. Giant has
another parent thought called Famous Giants.

e
oFamous .Glants oJack and t%e.Beanstock

(Giant)

oJolly G?ee.n Giant

Famous Giants has a child thought called Jolly Green Giant. Jolly Green Giant
has child thoughts named after canned vegetable products, one of which is
Asparagus. Thus, the Queen of England is connected to asparagus!

(o]
oFamous Glants

¢ Jolly Greehlant

o
OAsparagus 05eas
s © o
oCorn
o

Depending on the relationship you create between them, thoughts may be
closely or distantly related. Thoughts are considered to be closely related when
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they are linked directly or are siblings. In the default view of the plex, only close
thoughts of the active thought are always displayed in the plex. Thoughts that are
one additional step (generation) away from the active thought can be displayed
by expanding the view. See Advanced Navigation and Alternative Views on page
142 for information about the different view options.

Opening a Brain

When you log into TheBrain 13, and no brain is open, all local, synced or online
brains will be displayed as thumbnails in the Brains tab, as shown below. This is
assuming that you have already created one or more brains. Clicking on a brain
thumbnail opens that brain. Or, hold down the Ctrl key as you click to open a
brain in a new tab, leaving the Brains tab open.

”} File Edit Options Window Help - o X
Brains i.:.‘ @
©+ | C | az
Philosophy Marketing
P e ——
Product Research Jane's Brain

Figure 20. Example of Four Available Brains on the Brains Tab

By default, brains are listed according to how recently they have been accessed.
You can also see the list of brains sorted alphabetically using the Brains tab
toolbar, shown below. All brains that are locally available are shown first,
followed by brains that are available online.
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'> File Edit Options Window Help
= Brains
Sort Brains by last
/- » 4/accessed date
Create a =
new Brain

Refresh K Sort Brains by name

Figure 21. The Brains Tab Toolbar

The status of whether each brain is available locally, online, or both is also
displayed. Each brain in the Brains tab will have an icon appearing in the lower-
right corner of the thumbnail. Right-click on a brain or click on the status icon to
display a menu of options for that brain, as shown below. The appearance of the
icon(s) help you identify whether the brain is Local, Synced (local and online) or
Cloud (Online only).

/"’W - vp'v\

Product Research

[=s]

Figure 22. Icons Indicating Local, Synced, or Cloud

Local
Synced

Cloud

Figure 23. Status Indicator Icons

Opening a Brain that Doesn’t Appear as a Tab

If you have a brain from an older version or from a backup, it will not appear in
the Brains tab until you import it. Click the File menu, then the Import command.
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Choose the type of file you want to import, then click the Select File button,
navigate to the file of your choice, then click the Open button when the file is
selected. Click the Import button after TheBrain has finished converting the
brain.

Managing Brains Using the Tabs

The tabbed interface of the plex lets you switch instantly between brains or even
keep the same brain open in multiple Brain tabs or windows.

To re-open the Brains tab to display the Brain thumbnails, click the + icon to the
right of the last tab.

-

.> File Edit Thought View Options Online Window Help

Jane's Brain | Clients “k
AR (2 ]A A+a-
£ Personal Life Goals 4#Hobbies

Figure 24. Click the + Icon to Open the Brains Tab

There is no limit to the number of brains you can open at once. Each time you
) open a brain it will appear in a separate tab. Switch from brain to brain
. instantaneously by clicking its tab. All tabs and their states are automatically
saved and restored when you quit and restart.

= Float tabs into their own dedicated window by dragging a tab out of TheBrain
application window. This creates a new Brain application window with just a
single tab.

= Merge tabs into one window by dragging and dropping. Click the tab of one
Brain window and drag the tab to another open brain, hovering over the tab
area. Then release the mouse button.

= Open the same brain in multiple tabs to view and edit multiple areas at a
time. This lets you view different areas of your brain at the same time, and, if
you like, use a different layout in each tab. Note that tabs are simply views
into the same brain data and changes made in one tab affect all other tabs of
that brain.

= Duplicate tabs. Right-click on a brain tab to duplicate it, showing the same
content in a new Brain tab.
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Windows Menu

From Windows menu in the menu bar you’ll have the option to move between
brain tabs, move tabs to new windows or select a specific brain tab to be
activated.

Additionally, if you have adjusted the layout of a brain with the Smart Splitter, you
can select the option to Reset Window which will bring the plex/content area
back to their default views.

Managing Brains Using the Context Menu

You can right-click any brain in the Brains tab to display the available options.

Open Brain
Open Brain in New Tab

Open Brain in New Window

Or Open Brain to Home Thought
E Rename Brain...
Set Brain Icon
Hide Brain
Statistics

Brain Access and Sharing...

Backup to Brain Archive...

Export...

Perform Data Integrity Scan
Assign Brain New GUID...
Delete Local Brain...

Delete Remote Brain...

Figure 25. The Context Menu in the Brains Tab

Tip: Press Ctrl/Cmd + click to open a brain in a new tab from the brains list page.

Opening Content Associated with a Thought

As you navigate through your brain, the content associated with the active
thought is displayed in the content area. Notes associated with the thought are
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displayed automatically. There are several ways to open an attached file or web
page:
= Click on the link for the attachment in the content area.

= Click on the attachment icon to the left of the thought’s name in the plex.

= Right-click on the thought, click Open Attachment on the context menu, then
click the attachment of your choice.

Showing Thought Content on Hover

By default, the content for the active thought displays in the content area. If you
prefer, you can display content for any thought your mouse pointer hovers over
by changing the setting. To do so, click the Options menu (TheBrain menu on
macOS), click Preferences, click the Behavior tab, then select the “Update
displayed content on mouse hover or keyboard highlight” check box. Close the
Preferences window when you’re finished.

Previewing Thought Content

Certain types of file attachments are automatically previewed inside of TheBrain.
These include web pages, images, text, markdown files, JSON, .html files and
PDFs. Simply click on an attachment’s tab and its preview will be shown. In the
example below, Tropical Getaways is the active thought and there are two
attachments in the content area—an image and a PDF.

/ You can view multi-page PDFs, web pages, and images as a slide show within
. the content area.

= Click the link for an attachment to open a preview of it in the content area.

= Click the Next or Previous arrow in the top-right corner of the attachment to
move back and forth between attachments (or back to the notes in the
content area).

= Click the Close button (X) to end the preview and return to the notes.

= Click the Open button to open the file outside of TheBrain.
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Figure 26. Content Area for the Active Thought
The PDF preview features:
= Supported rendering for each OS
= Support for very large, multi-page PDFs
= Thumbnails of each page, zoom, rotation, search, and printing

= All PDF commands can be mapped to a custom keyboard shortcut

Editing Additional Notes

Adding additional attachments to a thought, such as .md and .txt files will enable
you to also edit these attachments the same as you would a brain note.

Pins

Pins are shortcuts to thoughts to which you want quick access. They appear at
the top of the plex, just below TheBrain toolbar. No matter where you are in your
brain, the pins remain visible.
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Figure 27. Pins

To create a pin:

= Use the Toggle Pin button in the main toolbar to create a pin for the Active
Thought or right-click the thought for which you want to create a pin, then
click Create Pin on the context menu

'} File Edit Thought WView Options Onl

Lee Sharpe | Mew York
(A RS A A A+ a

oggle Pin

Figure 28. Toggle Pin Button

To remove a pin:

= Use the Toggle Pin button in the main toolbar to remove the pin for the
Active Thought or right-click the pin or on a thought that has a pin, then click
Remove Pin on the context menu

, Removing a pin does not remove or delete the associated thought; it deletes
. only the reference to it at the top of the plex.
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To use a pin to link thoughts:
= Drag from one of the thought gates to the pin, or

= Move your mouse pointer over a pinned thought and gates will appear; drag
from one of these gates to the thought you want to link

Activating Recent Thoughts: The Past Thought List

TheBrain keeps a running breadcrumb trail of your thoughts based on activation
and displays it in the Past Thought List. You can think of the Past Thought List as
the visual representation of the phrase, “train of thought—a scrollable list of
thoughts in the order you activated them. The Past Thought List is displayed at
the bottom of the plex window.

Clicking on any thought in the Past Thought List activates that thought. Also,
when a new thought is created it appears in the Past Thought List immediately.

Scrolling arrows

Lt
[_qﬁ» Friends =+ Home Projects & My Passions "My Pet % Personal Finance @ Hobbies .

Figure 29. Past Thought List

The left and right arrows to the left of the Past Thought List enable scrolling to
see items that don’t fit on the display.

The most recently activated thought (the currently active thought) appears at the
right end of the list.

To use athought in the Past Thought List to link thoughts:

= Drag from one of the thought gates to one of the thoughts in the Past
Thought List, or

= Move your mouse pointer over a thought in the Past Thought List and gates
will appear; drag from one of these gates to the thought you want to link
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In the example below, Tropical Vacations is going to become a parent of Airline
Rewards; the mouse is being dragged from the child gate of Tropical Vacations
to Airline Rewards in the Past Thought List.

& I'm Most Int...
My Latest Pr...
Goals MyWork
Personal Life
What I'm Thi...
— -
Retiring at 50 o}4 Tropical Vacations
v\’/r
]
Joa
4 > Ret o I'm Most Interest Tropical Vacations ine's Brain

Figure 30. Creating a Link using the Past Thought List
Using the Back and Forward Buttons:

= |n addition to the Past Thought List, you can also use the Back and Forward
buttons, located near the top of the Window, to quickly retrace your steps;
these buttons work just like they do in a web browser

-
.> Eile Edit Thought View Options Online Window Help

Jane's Brain | Jane's Brain

4|ﬁl§5 A (Al A+~

% Personal Life Goals ¢iHobbies

= Click the Back button to go back to the last active thought

= Once you have clicked the Back button, the Forward button can be used to
re-activate the thought you came from
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M Back and Forward Mouse Buttons: The back and forward buttons available on
some mice (typically on the left side of the mouse near where you place your thumb)
may be used to navigate backward and forward in your brain. These mouse buttons
perform the same navigation as the Back and Forward buttons in the Brain toolbar,
shown above.

Searching a Brain

Instant Activation

TheBrain includes powerful search capabilities. The Search box is in the top-right
area of the application.

S P
= aff Jo

Figure 31. The Search Box

The term “instant activation” refers to TheBrain’s ability to quickly find whatever
you’re searching for and activate the related thought. You can easily scan the
search results as you type in the Search box. There's no need to click in the
Search box, your cursor is always there by default, unless you are actively typing
in the content area or another field.

A content area preview will automatically appear for each choice you highlight.

To activate one of these results, click it with your mouse or use the up-arrow,
down-arrow, page up, and page down keys on the keyboard then press the
Enter key.
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Figure 32. Instant Activate Finds Matches Based on Thought
Names, Labels, Notes, and Attachments

s

thoughts are also displayed so you can differentiate them.

Accents are ignored when matching thought names. Also, when two or more
matches with the same name are found, the names of their parent or jump

You can search for thoughts by typing the first letter(s) of separate words and the
letters can be in any sequence; for example, to find the “Family and Friends”
thought you could type “fa fr,” or “fr fa,” or “fa and fri.”

1 match

+ Create Jump
Thoughts, Links and Events

Figure 33. Use First Letters
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Attachments and note search matches are identified with a yellow piece of paper
icon for notes and a paper clip icon for Attachments.

= (1 [mar ]‘

8 matches ] Childward only =

+ Create Jump

¥ Web Marketing
2 VP of Marketing
% Target Markets
Notes and Internal Attachments
[E® Increase Sales
Territories
= vIP Clients
External File Attachments
@ Marketing Events.docx ¢ Publicity Events

Figure 34. Search Results

When you do a search, the results are sorted with results that match thought
names first, then notes, then attachments. Within the thought name matches,

they are ranked in groups:

= Exact Matches—where the entire name of the thought matches the entire
query

= Starting Matches—where the entire query occurs at the start of the thought
name

= Continuous Matches—where the entire query occurs anywhere in the
thought name

= Matches—where every term in the query occurs somewhere in the thought
name

Within each group, thoughts that have been activated in the last 30 days will be
shown first, ordered with the most recently activated first. Thoughts that have not
been activated within 30 days are sorted alphabetically.

Searching within Attachments

0} Pro

. Your searches automatically include matches based on the contents of
attachments. If the text you're searching for exists within documents including
PDFs, Word, Excel, PowerPoint and many other file formats, the documents
containing the text will be found.

TheBrain 13 User Guide 31



Navigating Your Brain

On Windows, TheBrain utilizes Windows Search to provide search results to
Brain notes and file attachments.

TheBrain integrates with Spotlight on macOS to provide search results from
within file attachments. No setup or additional steps are required to enable this
functionality.

Y
~ R

For searches in TheBrain to return accurate results, Windows Search or
Spotlight will need to have access to the location where your brains are being
stored.

N\

Using the Search Box to Search the Web

Say you're searching for something and come up with no hits. For example,
you’re on a neighborhood committee and you’ve volunteered to look into an issue
with squirrels. You type “squirrels” in the Search box. No results? Press the F4
key to search the web.

= Oy
= [B | squirrels (]
0 matches | *2= Web Search X [] Childward only | =
— e ————
i+ Create |
................ squirrels :—:“;‘“;.";_;."L — sart
Search Engine: | Google ¥, | Edit | B 3¢ 6 14 words
Google | | ==
Bing Close
DuckDuckGo 1 P
mes-coie [1@S Brain
Images - Bing
Twitter
YouTube
o self
Amazon
rk eBay
Life Yahoo ew neighbor
Wikipedia e mirror
3 About Now 7 Smile at strangers!

Figure 35. Search-Engine Choices

= Click the drop-down arrow if you want to select a different search engine,
then click the Search button to begin searching the web based on what
you've typed.

=  When you find a site you like, you can add it to any thought in the usual way.
The Web Search box will close automatically after you click the Search
button.
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To modify, add, or reset search-engines:

=  Click the Edit button in the Web Search box.

<>

squirrels

Search Engine: | Google

=
*> Web Search X
Name URL String
Google http://www.google.com/search?q=TARGETSTRING
Bing http://www.bing.com/search?q=TARGETSTRING
DuckDuckGo https://duckduckgo.com/?q=TARGETSTRING

Images - Google | |https.//www.google.com/search?q=TARGETSTRING&ssafe=off&source=Inm

Images - Bing http://www.bing.com/images/search?q=TARGETSTRING

Twitter https://twitter.com/search?q=TARGETSTRING

YouTube https://www.youtube.com/results?search_query=TARGETSTRING
Vimeo http://vimeo.com/search?q=TARGETSTRING

Amazon http://www.amazon.com/s?field-keywords=TARGETSTRING
eBay http://search.ebay.com/search/search.dll?satitle=TARGETSTRING
Yahoo http://search.yahoo.com/search?p=TARGETSTRING

Wikipedia http://en.wikipedia.org/wiki/Special:Search/TARGETSTRING

Figure 36. Editing Search-Engine URLs
To customize the search-engine choices:
= Click and edit any URL string to customize it, or
= Click the Add New button to enter a name that isn’t already in the list, or
= Click the Reset button to return to TheBrain’s default choices
Click the OK button to save your customizations or click the Cancel button to

close the box without making changes. The original Web Search box will still be
open, still showing the text you were searching for.

Additional Search Functionality

Search has several additional capabilities that are automatically enabled.

= You can find and execute commands from the Search box. To begin, type a
forward slash (/) in the Search box. An alphabetical list will appear. The list
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will be fine-tuned to match what you type. This option can also be accessed
from the Search Commands and Preferences option under the Help menu.

- [0/ 0

332 Commands

Application » About

I%

Application > Offline License Activation
Application = Check for Update
Application > Exit

Application = Export Shortcuts
Application > Import Shortcuts
Application > Manage Endpoints..
Application > Open Log Directory
Application > Contact Us

Application = Preferences... » Ctrl+,
Application = Show Account Info

Application = Show Tips

PR TR SR P T T

Figure 37. Executing a Command from the Search Box
= External attachments are included in search results

= Search using acronyms (ex. find "New York Stock Exchange" by typing
"nyse")

= Search for thoughts starting with punctuation. You may use this as a shortcut
to provide fast access to thoughts that you always start with a certain type of
punctuation. For example, you could use this for people (@Mike, @Sally,
@Debbie, etc.) or projects (#Ridgeline, #Palmdale, #Westly, etc.)

e [ [y |

2 matches 1 Childward only |=

Motes and Internal Attachments

- « Villa House

External File Attachments

@ 8 July.docx = 3rd Quarter Invoice

Figure 38. Search Results for Both Internal and External Attachments

= Below the search box is an option for searching Childward only. Selecting this
option will limit the search results to 3 generations below the current active
thought.
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Customizing Your Brain’s Environment

You may choose to use your brain just as it's offered “out of the box” or you may
choose to change some of the environmental settings to suit your personal
preferences.

TheBrain’s Default Settings

Without making any changes, here’s what your brain looks like:

= The area where your thoughts appear (the plex) will be the color and design
of one of TheBrain’s “Themes.” The initial theme is randomly selected and
you can change it at any time.

The left half of TheBrain window will display your thoughts and the right half
of the window will display the “Content Area” which holds notes and any other
items you will attach to your thoughts—files, web pages, Events, etc.

= Your thoughts will be displayed in “Normal” view, meaning that you will see
only the direct parents, children, jumps, and siblings of the active thought.

'} File Edit Thought View Options Online Window Help

- o X
Jane's Brain | Jane's Brain :".‘.1 @
CARS | A@A A E = LY
4 Personal Life + Goals Hobbies A S BJ7 UG S S S A F A& :=
SAEEEE=ESC @ noo [iem| v Mo | S
L= BT !

§%] Jane's Brain

{ﬂ.jJar?e‘s Brain Notes to self

Meet the new neighbor
O Smile at the mirror

é % O Smiile at strangers!
Goals *_g My Work
o/ ® e ®
of" I'm Most Interested In... o4 Personal Life
bk
o® My Latest Preoccupations >~ What I'm Th‘lnking About Now . .
. . Jane's Brain
6 Mapped Links
! Goals
1 I'm Most Interested In...
1 My Latest Preoccupations
1 1 My Work
» 1 Personal Life
<« > New Recommended 5 Tropical Geta.. @My Latest Pre.. [Jane’s Brain { What I'm Thinking About Now

Figure 39. TheBrain Window with Default Settings

Using Smart-Splitter to Arrange TheBrain Window

The smart-splitter controls let you manage where the plex and content area
display relative to each other in the Brain window.
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,’> File Edit Thought View Options Online Window Help = m] X
() Jane's Brain | New York ‘E” @
CARS | @A A+ @~ =N (U
2 Personal Life Goals ¢&Hobbies X [ New York > Empire State Bui... D= = &

C, @ https://www.tripadvisor.com/AttractionProdu

QO0OP 0 282 reviews

1
OCh.icago 1
olos ,Angeles ‘ ,U

o oSan Frarg)cnsco &

@
oTokyo

(J
oL, U rban'TraveI

Toggle maximizing right side 3
SO o |
Toggle maximizing left side \'
Toggle Plex/Notes left/right or up/down 4
Toggle side-by-side/under over |t3| rq About o QO
b
[
< > % Tropical Getaw... @My Latest Preo... [fjJane's Brain i Urban Travel @ New Yor :_‘_.: No visit to New York is complete v

- s

Figure 40. Smart-Splitter

= Click the individual left- and right-arrows (or up- and down-arrows if the
window is in “over-and-under” mode) to maximize the area the arrow is
pointing towards (either the plex or the content area).

= Click the double-headed arrow icon to toggle the plex to the right or left side
of the content area.

= Click on the two-arrow icon that forms a box to toggle between seeing the
plex and content area "side-by-side" or “over-and-under.”

= You can also point at the border between areas and click and drag when the
double-headed arrow appears to move the border.

Moving Thoughts in the Plex

When the default settings are in use and the plex is in “Normal” view, you can
move the thoughts in the plex up or down, vertically, by dragging (up or down) in
any blank area of the plex background.
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Jane's Brain | Jane's Brain
O ARS e A R

A Personal Life - Goals :¢Hobbies

Before dragging Plex down

JandgBrain | Jane's Brain

hlaﬁe's Brain| CARY (A A A

4 Personal Life WGoals : Hobbies
L) e
o Goals e.aM
o ® .
I'm Most Interested In... o4 Pers
e © .
oW My Latest P:eoccupati,.. o" What I'm
After dragging Plex down
¢l Jane’s Brain|
< P> @ New &UrbanTr.. #&Travel 4 Person E
L) -
o+ Goals o.g My Work
(Y4 - ®
of" I'm Most Interested In... ol Persor:al Life
o © .
@ My Latest Preoccupati... ©° What I'm Thinking Ab...
<« > @New %UbanTr. ATavel ZPersonal.. WiJane’s Br... gy

Figure 41. Dragging the Plex Vertically

Resizing Thoughts in the Plex

The plex is the heart and soul of TheBrain. You can change the size of thoughts
in the plex by using TheBrain toolbar or your keyboard and mouse.

To change the size of thoughts using the toolbar:

= Click the AA button to activate the slider, then click and slide the bar up or
down to grow or shrink the size of your thoughts.
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Jane's Brain | Jane's Brain
CARS | 2wlAllA @

4 Personal Life Goals & Hgb

Jane's Brain | Jane's Brain

A+|@

Hies

@]Jane's Brain

o Goals

Ty
° l‘mMostlngerestedlnm '
o'MyLatest'Prgoccupations o % What

{hJane's Brain
E

o .Go.als o5 I\zy \.Nork
off I'm Mc.)stolnterest... ofk Per‘sorlal Life
o@ My Lafest. Preocc... o What T‘m.Thinkin...

Figure 42. Resizing Thought Size with the Slider
To change the size of thoughts using the keyboard, mouse, or trackpad:

= Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and scroll up or down
on your mouse wheel or trackpad while your mouse pointer is in the plex.

1

Ctrl = / ¥} & + or N

Figure 43. Resizing with the Mouse or Trackpad

= Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and press - to make
thoughts smaller or + to make thoughts larger.

=+

Ctrll/ﬁ%c+' Or=

Figure 44. Resizing with the Keyboard
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= Pinch to zoom on a macOS Trackpad.

LARGER SMALLER
L‘ O
el g 2
|7 a1
¥ =N Y VI )
/ Dt ‘(// /

Figure 45. Resizing on a Trackpad
Customizing a Brain’s Appearance

Selecting a Theme

The Themes feature lets you choose from many built-in designs to customize the
look of your brain, including the appearance of the plex and notes in the content
area. You can change many of the default colors and the style of notes
associated with the Theme, then save the look of your brain as a new Theme.
This lets you quickly switch from one saved Theme to another.

(©) Jane's Brain | Jane's Brain

() Jane’s Brain | Jane’s Brain OCARS | 2tElal Aar
CARS 2wl A @ "

4 Personal Life + Goals Hobbies

E’Jaﬁe‘s Brain
=

¢4 Jane's Brain

U i
o Goals
o/ ® .
of I'm Most ln(t)erested In... o4 Persc
* °
©@ My Latest Preoccupations © % What I'm Thin

< @New York % Urban Travel #Travel 4 Personal’
\

>

e 1
T . @ Jane's Brain|
ane's Brain X &
- . =]

o..n My Work
= i o
* Gogals #f: My Work ©.4 Personal Life
#® I'm Most Interested In.. »” Prrr.or.m\ Life L i o What I'm Th.ink.ing About Now

My Latest Prso:cupahuns @ What I'm Thu\k.mp! About Now

% Urban Travel & Travel 4 Personal Life  §jJane’s Brain

Figure 46. Sample Themes
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To select a Theme:

1. Either click the Options menu in TheBrain toolbar (TheBrain menu on
macOS) or right-click any blank space in the plex.

2. Click the Brain Theme command.

P
°> File Edit Thought View | Options | Online Window Help

Arrange Thoughts by »
Web Search... F4

() Jane's Brain | Jane's Brain
ORRPD 2 AA

| £ Personal Life Goals @& Hol

Command Search

Show Forgotten Thoughts

s Hide Private Thoughts

[‘., bl Wander Ctrl+Shift+L
; Check Spelling as You Type

Show Markdown

I Brain Theme... N ]

AT

Preference
(ﬁnﬁ'i"?ﬁ_ﬁ'rj Alter the look of this brain l;

L) 5 [ ]
o Goals e .5 My Work
o ® o ©®
A Nma MAact lnbavackad Tn A Davenna 1A

Figure 47. Accessing the Brain Theme Dialog Box

In the Brain Theme box, you'll see a scrollable list of available themes in the left
panel and Colors and Options tabs in the right panel. Click on any Theme to
see how it looks in the plex.
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*2 Brain Theme X
Themes Callers
Custom Settings Background, center &
Background, top and bottom x)
- Classic Dark Blue Thoughts, text o
i htBIueDefauIt """""" i Thoughts, text shadow Q
'''''''''''''''''''''''''''''''' Thoughts, background (@)
# 20 Years Highlighted Thoughts [ ]
# 20 Years-Light Ll_nksl )
Highlighted Links L
# Brain Animals Gates [ ]
. . . Highlighted Gates [ ]
#B A Is-Light
fam Anmals=tg Active Thought, outline o
# Brain Waves 1 Focused Thought, circle Q@
) Scrollbars, fill [ ]
# Brain Waves 2 Scrollbars, outline o
# Brain Waves 3 Highlighted Scrollbars [ ]

Figure 48. The Brain Theme Dialog Box

Customizing a Theme’s Colors

, Have the Brain Theme box open when you want to customize a Theme (right-
. click a blank area of the plex, then click the Brain Theme command).

The default colors for virtually all items in the plex vary based on the selected
Theme. The current color for each item is shown in the circle to the right of the
item’s description. Scroll through the list in the Colors tab to get an idea of all of
the items that can be changed.

To change the colors in the selected Theme:
1. Click the item whose color you want to change to display your choices.

2. Click the color of your choice, click outside of the box of colors to close it,
then click Close (X) (or press Esc) to close the Brain Theme box.
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My Brain

| 5 Mapped Links
o] Goals <>
o/ ®
of" I'm Most/Interested In...

.k My Work Themes Colors
L4 Custom Settings Background, center O
. Background, top and bottom Q
- Classic Dark Blue Thoughts, text o put Now
- Light Blue Default Thoughts, text shadow @] [
Thoughts, background O
# 20 Years Highlighted Thoughts [ ]
# 20 Years-Light Links 2

Highlighted Links
# Brain Animals Gates
Highlighted Gates
Active Thought, outline
# Brain Waves 1 Focused Thought, circle
Scrollbars, fill
Scrollbars, outline
# Brain Waves 3 Highlighted Scrollbars

. Custom

# Brain Animals-Light

# Brain Waves 2

Figure 49. New Selected Color for Links

Note that while you can change the color of the shadow for thought text using
the theme’s Color tab settings, you can toggle whether or not text shadows
, are displayed using the Look & Feel tab of the Preferences window (as
’ explained in the Look & Feel Preferences section on page 59). By default, text
shadows are displayed.

When you are happy with your color selections, click the Close button (X) in
the Brain Theme box.

Defining and Selecting Additional Colors
You can add customized colors if you don’t see the exact shade you want.
1. In the color selection box, click the color that’s closest to what you want,

then click the box next to “Custom,” then click the Define Custom Colors
button.
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)
=X
o
2

X

Colors Options S
35 -~ Background, center O

Background, top and bottom @]
3lue Thoughts, text () put Now
fault Thoughts, text shadow A

Thoughts, background
Highlighted Thoughts
Links

Highlighted Links

s Gates

Highlighted Gates
Active Thought, outline
1 Focused Thought, circle
Scrollbars, fill

Scrollbars, outline

P . Custom
3 v Highlighted Scrollbars - Define Custom Colors >>

OK I Cancel |

1t
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11 HEEEEN
11 HEEENT]
11 FAENEE
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1]
1]
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Figure 50. Define a Custom Color

2. The Color window will expand to provide a slider to fine-tune the shade.
You can also select a different color and fine-tune it or type in specific RGB
or HSL numbers. Click the Add to Custom Colors button when you’re

happy with the sample color, then click the OK button.
X

Hue 2 Red 235
Sat: (136 Green: |182

r
Color

Basic colors:

EEEEE[
HEEE T |
EEEEET

9]

ustom colors:

1T HAEEEN
T HEEEET
1T FAAANEN
T AEEENT
T HAEEE

1M
1
1

Define Custom Colors == | Colar|Solid | - [196 Blue: |230
OK | Cancel | | Add to Custom Colors R |
iy

Figure 51. Adding a Custom Color

Selecting a Custom Image for the Plex

If you want to use an image of your own instead of using one in the Themes list
of the Brain Theme box, it's very easy to do so.
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To select your own background image:

1. Click the Options tab in the Brain Theme box, then click the Wallpaper
check box.

| ==
Themes Options

Custom Settings Plex

- Classic Dark Blue %Wa\lpaper

- Light Blue Default

# 20 Years Font Helvetica v
# 20 Years-Light

Notes

# Brain Animals Edit Notes Style

# Brain Animals-Light
# Brain Waves 1
# Brain Waves 2

# Brain Waves 3

Figure 52. Options Tab in the Brain Theme Dialog Box

2. Inthe Select image file as the wallpaper window, navigate to the location
of your image file, click on it, and then click the Open button. Supported
wallpaper file formats include .jpg, .gif, and .png.

3. Click the Close button (X) in the Brain Theme box to save your new image
for the plex.

To replace, remove, or copy a wallpaper image:

= To replace the image, click the Select button next to the Wallpaper check
box to navigate to a different image.

= To remove the image, click the Wallpaper check box to toggle off the check
mark and remove the image from the plex.

= To copy a wallpaper image to your clipboard, click the Copy Wallpaper
button
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| =2 Brain Theme x|
Themes Options
Custom Settings Plex
- Classic Dark Blue
Wallpaper m
[scect.|

- Light Blue Default
| Copy Wallpaper |

# 20 Years

Horizontal Align Center ©
# 20 Years-Light
X . Vertical Align Center o
# Brain Animals
# Brain Animals-Light Font Helvetica v

# Brain Waves 1

i Notes
# Brain Waves 2

Edit Notes Style |

# Brain Waves 3

|
- —d

Figure 53. Replacing or Removing Wallpaper

To dynamically select new Wallpaper from a web site:

1. Go to a web site that offers Wallpaper files, right-click the design of your
choice, then select Copy on the context menu.

2. Return to your brain, right-click in any blank area of the plex, then select
Paste Wallpaper on the context menu.

n|

Paste File

| Past?,\wWallpaper |

Arrange Thoughts by »
Layout 3

W Expand All Ctrl+0
Collapse All

Right Panel

Timeline

Brain Theme...

Presentation Mode

Figure 54. Context Menu on the Plex

Changing the Default Font in the Plex

By default, the font for text that appears in the plex is Helvetica. You can change
it to any font installed on your machine:

1. Click the Options tab in the Brain Theme box, then click the drop-down
button for Font.
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| & Brain Theme X
Themes Options B
Custom Settings Plex 3
- Classic Dark Blue Wallpaper
- Light Blue Default | Copy Wallpaper |
# 20 Years
Horizontal Align Center O
# 20 Years-Light
. . Vertical Align Center v
# Brain Animals
# Brain Animals-Light Font Helvetica v
# Brain Waves 1 Agency FB
. Notes .
# Brain Waves 2 Algerian
Edit i H
# Brain Waves 3 All Things Pink
All Things Pink Skinny E
Amatic SC
Angelina
Another Typewriter L' ik
Arial [ |
Arial Black
Arial Narrow tio
Arial Ranindad MT Rald I

Figure 55. Changing the Font for Plex Text

2. Click the font of your choice. You will see the text in the plex update
automatically.

Changing the Content Area’s Default Attributes

You can select custom colors for your notes’ text, links, page, edge, and
background. You can also change the font, size, weight (boldness), and other
attributes for the heading and body text you include in the content area—either
before or after you add it. Prebuilt Styles are also available, which you can use
as-is, or modify. You'll see instant previews of the changes you make, before you
apply them. And, of course, you can change your changes anytime.

By default, the notes in the content area of your brains appear in a style called
“Modern,” which is a sleek and clear combination of font, color, and size.

To begin selecting different style attributes for notes:

= Click the Edit Notes Style button on the Options tab in the Brain Theme
box, or

= Click the Notes Style button in the content area toolbar
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| *2» Brain Theme X |

Themes Options

Custom Settings Plex

- Classic Dark Blue [] Wallpaper

- Light Blue Default |

Copy Wallpaper |

# 20 Years
Horizontal Align Center "

# 20 Years-Light

. . Vertical Align Center v
# Brain Animals
# Brain Animals-Light Font Helvetica v
# Brain Waves 1

Notes

# Brain Waves 2

) Edit Notes Style |
# Brain Waves 3 {¥

Figure 56. Changing the Style of Notes

You

can also access the Edit Notes Style dialog box from the content area

toolbar. See Choosing a Notes Style beginning on page 163.

To change the appearance of headings:

1.

TheBrain 13 User Guide

Click on an example heading for the level you want to change. For
example, click on “Title Example Text” to change the top-level heading.

Select an attribute from the context menu. Selecting Font, Weight, Color,
or Letter Spacing will take you to an additional set of choices.

47



Customizing Your Brain’s Environment

<2 Edit Notes Style X
Click a paragraph or A
| heading to change the
font, justification and - *
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paragraph type. Title
| Font:
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Large v Heading 1/Label Example Text
. — Aliquam ultrices sagittis orci a. Dignissim diam quis enim lobortis. Aliquet
EecbuilSiyles = porttitor lacus luctus accumsan. Dignissim convallis aenean et tortor at
— - risus viverra adipiscing at.
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Magazine Egestas egestas fringilla phasellus faucibus scelerisque eleifend. Sagittis
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Figure 57. Style Options for Content Area Text

Original heading color \

/ . Custom — \
- e

Title Example Te;™ ..

Font:
Click here to change settings for normal pe, et " e
heading to change their settings. Colors cg|  Color D Default Color
to the left. Letter Spacing > E Custom Colur,.h
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All-C
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anewcolor | _y Title Example Text
\_/

Click here to change settings for normal paragraphs. Clicking a title or
heading to change their settings. Colors can be modified using the controls
to the left.

Figure 58. Before and After Changing a Heading Color Style
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To select a heading color that isn’t in the palette:

= Click Custom at the bottom of the color palette, click Define Custom Colors,
select a color you like, then click the OK button.
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Figure 59. Options for Fine-Tuning Heading Text Color

To change the size of headings:

= Click Small, Medium, or Large in the Heading Sizes list. The sizes will
adjust automatically, based on the level of each heading.

<>

Click a paragraph or
heading to change the
font, justification and

Title Example Text

paragraph type.

Colors Click here to change settings for normal paragraphs. Clicking a title or
Text [ ] heading to change their settings. Colors can be modified using the controls
Link ® to the left.
Page 8
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" = Aliquam ultrices sagittis orci a. Dignissim diam quis enim lobortis. Aliquet
frabuiteStyles = porttitor lacus luctus accumsan. Dignissim convallis aenean et tortor at
| risus viverra adipiscing at
Custom
Light 3
9 Heading 2 Example Text
Modern
Magazine Egestas egestas fringilla phasellus faucibus scelerisque eleifend. Sagittis
Del Rey | orci a scelerisque purus semper eget duis. Nulla pharetra diam sit amet nis|
N suscipit. Sed adipiscing diam donec adipiscing tristique risus nec feugiat
Brochure in
Deco
B

Figure 60. Options for Changing Heading Size
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To change the color of non-heading text and other Content Area parts:

1. Click the round color sample in the left panel for the element you want to
change.

2. When the palette opens, click the new color of your choice, or click Custom
to select a different color. The example text will immediately reflect your
choice. The palette stays open so that you can see what different colors
look like when applied.

3. Click outside the palette to close it, when you're ready.

<2 Edit Notes Style X
Click a paragraph or
heading to change the
font, justification and .
Title Example Text
paragraph type.
LEE Click here to change settings for normal paragraphs. Clicking a title or
Text IS [ ] _heading to change their settings. Colors can be modified using the controls
Link [ ]
Page O
Cursor [ ]
Edge iple Text
Background
o ;, consectetur adipiscing elit, sed do eiusmod
s et dolore magna aliqua. Dolor sed viverra ipsum
Small Il cusom n. Link example text.
Medium
Large Heading 1/Label Example Text
. — Aliquam ultrices sagittis orci a. Dignissim diam quis enim lobortis. Aliquet
EecbuiltStyles = porttitor lacus luctus accumsan. Dignissim convallis aenean et tortor at
—— risus viverra adipiscing at.
Light N
9 Heading 2 Example Text
Modern
Magazine Egestas egestas fringilla phasellus faucibus scelerisque eleifend. Sagittis
Del Rey orci a scelerisque purus semper eget duis. Nulla pharetra diam sit amet nis|
Broch suscipit. Sed adipiscing diam donec adipiscing tristique risus nec feugiat
rochure N
in.
Deco
Aoply

Figure 61. Selecting a New Color for Body Text in the Content Area

To change the font or weight of non-heading text:

1. Click within any non-heading body text, then choose either Font or Weight
in the context menu.

2. To change the font, select a choice in the scrollable list that appears—you’ll
find over 1,000 options. Each has a sample of how it will appear.

3. Press Esc or click outside of the list to close the box if you don’t want to
make a selection.
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Montserrat

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
termpor incididunt ut labore et dolore magna aliqua. Dolor sed viverra
ipsurm nunc aliguet bibendum enim. In massa tempor nec feugiat. Nunc
aliquet bibendum enim facilisis gravida. Nisl nunc mi ipsum faucibus vitas

Sort: | Popularity v | [ Only Recent Fonts
The quick brown fox jumps over a lazy dog.
The quick brown fox jumps over a lazy dog.

The quick brown fox jumps over a lazy dog.

L

The quick brown fox jumps over a lazy dog.

The quick brown fox jumps over a lazy dog.

The quick brown fox jumps over a lazy dog.

The quick brown fox jumps over a lazy dog.

The quick brown fox jumps over a lazy dog.

1 to 25 of 1068 matches shown. | Prev | | Next

Figure 62. Changing the Font of Content Area Body Text

4. To change the weight (the width/boldness of the characters), select a
choice from the list that appears.

Lorem ipsum dolor sit amet, consectetur adipiscing el
tempor incididunt ut labore et d~loramraanaaliayg D¢
nunc aliquet bibendum enim. Li 100
200
Heading Example Te) i
|| 400
500
Aliquam ultrices sagittis orci a. 600 quis e
porttitor lac ) D rallis 2
risus viverr Rl
Font: 800
Subheadin Weight N d 900

Figure 63. Changing the Weight of Content Area Body Text

Viewing and Selecting Prebuilt Styles

A handy way of seeing combinations of options for the content area is to visit the
Prebuilt Styles—if you see one you like, apply it to your brain and see the results
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instantly. The list of Prebuilt Styles is grouped into Light, Dark, and Fun
sections.

As you click each Prebuilt Style, you'll see the Example Text instantly reflect the

look.

Click a paragraph or

heading to change the

font, justification and °

Title Example Text

paragraph type.

Coloss ) = {for normal paragraphs. Clicking a title or
Text [} Prebuilt Styles = gs. Colors can be modified using the controls
Link [ ]

Page O Custom £
Cursor [ n [ .
Edge O Light % ~
Background G Modern Draft
_ i Dark
Heading Sizes Magaz|ne % Grimoire A
Small Del R Nocturne
; €l Rey Parklands
M 2
it Big Blue
Large Brochure Fun %
Conglomerate
Deco . Campfire
Prebuilt Styles . Cold Logic
e risus viverra adi Certificate
Grimoire . Bureau
Parklands PR T . Codex
Fun . — .
. Confectioner
Campfire Egestas egestas fringilla phasellus faucibus . v
Certificate orci a scelerisque purus semper gget duis. N P
Codex suscipit. Sed adipiscing diam donec adipiscing tristique risus ngc feugiat
) in. Fusce ut placerat orci nulla. Pharetra vel turpis nunc eget lorem dolor.
\g| Confectioner Tristique senectus et netus et malesuada. .

Figure 64. Selecting a Prebuilt Style

Copying, Pasting, Importing, and Exporting Styles

You can copy, paste, import, and export styles, making it easier to create new
styles. Click the Actions button to display the Copy, Paste, Import, and Export
options for Styles.

— Aliquam ultrices sagittis orc
Prebulit Stiies @ porttitor lacus luctus accum
Grimoire Copy Notes Style ing at.
Parklands Paste Notes Style

Paste Colors Only lle Text

Fun

Export Notes Style... ;
Campfire hgilla pha
Import Notes Style...

Certificate urus senn
B suscipit. Sed adipiscing .dlan

. in. Fusce ut placerat orci nul
e y Tristique senectus et netus ¢

Figure 65. Selecting a Prebuilt Style
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= Copy Notes Style—Click when you want to apply the current notes
formatting in another brain.

= Paste Notes Style (available if a note style has been copied)—Click after
you’ve opened the brain to receive the style.

= Paste Colors Only (available if a note style has been copied)—Click after
you’ve opened the brain to receive the color choices in the copied style.

= Export Notes Style—Click Save after navigating to a location of your choice
for saving the style file. The filename will look like this: Style-2021-08-
13.nstyle (except with the actual date you exported the file).

= Import Notes Style (available if a note style has been exported)—with the
receiving brain open, choose this option, navigate to the location of the
.nstyle file, click Open when the file is selected, then click the Apply button.

Saving Changes

When you are happy with your content area choices, click the Apply button, then
close the Brain Theme box to return to your brain.

Reverting to the Theme’s Default Settings

) As soon as you make any changes to a Theme, “Custom Settings” will be
. selected in the Themes list.

To switch back to the original settings for any Theme, select the Theme name in
the Themes list within the Brain Theme dialog box.

Saving Themes
1. Make sure the tab with the brain that has the Theme you want to save is
active in the plex.

2. Unless the Brain Theme box is already open, either click the Brain Theme
command on the Options menu or right-click a blank area of the plex, then
click the Brain Theme command.

3. Click the Save Theme button, click Save as New (so you don’t overwrite
the original Theme), then type a name for your new theme in the field.
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* Brain Theme X

Lot il

. 3

Themes Colors Options L
Custom Settings ~ Background, center ®
Background, top and bottom x)
- Classic Dark Blue Thoughts, text ®
 Light Blue Default Thoughts, text shadow [ ]
Thoughts, background O
# 20 Years Highlighted Thoughts O
# 20 Years-Light L'Pksl . e
Highlighted Links @
# Brain Animals Gates ®
. . Highlighted Gates O

# Bl A Is-Light

ram Animais g Active Thought, outline O |
# Brain Waves 1 Focused Thought, circle [
‘ Scrollbars, fill [ ]

o Brain Wavese Scrollbars, outline [ ] |
# Brain Waves 3 V) | | Highliahted Scrollbars (@)

S 1
«> Save Theme X
| My New Theme | :llmport
| 0K | | Cancel |

Figure 66. Save a Theme

4. Click the OK button. Your new Theme will be inserted into the list of
Themes, ready for use in your other brains.

*2» Brain Theme X |

- f

Themes Colors Options |
City Lights ~ Background, center @)
Background, top and bottom QO
Clean Sky Thoughts, text [ ]
Clouds 2021 Thoughts, text shadow [
Thoughts, background O
Crisp Highlighted Thoughts O
Dark Gray Ll.nks‘ ) ®
Highlighted Links L ]
Dream Logic Gates o
Highlighted Gates O
geyser Active Thought, outline (@)
Light Gray Focused Thought, circle [
Scrollbars, fill [ ]
| My New Theme | Scrollbars, outline [ ]
Purple Prince W v Highlighted Scrollbars Q

Figure 67. Newly Saved Theme in the Themes List

, Your saved Theme will also include customizations you have made in the Edit
. Notes Styles window.

TheBrain 13 User Guide 54



Customizing Your Brain’s Environment

Renaming a Theme

1. Inthe Brain Theme box, click the Theme you want to rename, then click
the Rename button.

2. Type or revise the current name, then click the OK button (or press the

Enter key).
> i
Themes Calars
City Lights Background, center @]
Background, top and bottom O
Clean Sky Thoughts, text o
Clouds 2021 Thoughts, text shadow
Thoughts, background O
|| Crisp | | Highlighted Thoughts O
Dark Gray *2» Rename the Selected Theme X :
_ Dream Logig |My New Theme | !
i geyser =
| ) | 0] ¢ | | Cancel | ~
i Light Gray | _ =l [ ]
i Scrollbars, fill [ ]
My New Theme | Scrollbars, outline ®
Purple Prince v Highlighted Scrollbars @]

Figure 68. Renaming a Theme

3. Click the Close button (X) to close the Brain Theme box.

Deleting a Theme

1. Inthe Brain Theme box, click the Theme you want to delete, then click the
Delete button.

Clicking on a Theme that you want to rename will activate this Theme in your
brain. You may want to save your current Theme first (if it has been
customized) before renaming another, existing Theme.
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*2* Brain Theme X G <
Themes Colors - Options r el
City Lights ~ Background, center (@]
Background, top and bottom @]
Clean Sky Thoughts, text [ ]
Clouds 2021 Thoughts, text shadow o
Thoughts, background @]
| Crisp || Highlighted Thoughts Ol [
=2 Delete Theme X

This theme will be deleted. Are you sure?

| DeITte | Cancel |

| Purple Prince v | | Highlighted Scrollbars O |

Figure 69. Deleting a Theme

2. Click the Delete button to confirm that you’re sure you want to delete the
Theme.

3. Click the Close button (X) to close the Brain Theme box.

Importing and Exporting Themes

2> Brain Theme X
} |
Themes Colors Options |
- Classic Dark Blue ) Background, center 0
Background, top and bottom )
| - Light Blue Default Thoughts, text o
#20 Vears Thoughts, text shadow o
Thoughts, background O
l # 20 Years-Light Highlighted Thoughts ®
# Brain Animals L|r1ksl ) o
Highlighted Links ®
# Brain Animals-Light Gates o
i . Highlighted Gates o
#B W, 1
| rain Waves Active Thought, outline o
# Brain Waves 2 Focused Thought, circle Q@
) Scrollbars, fill o
# Brain Waves 3 Scrollbars, outline o
# Cold Ocean v Highlighted Scrollbars [ ]
| [l

Figure 70. Importing or Exporting a Theme
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To import a Theme:

= Click the Import button, navigate to the location of the .BrainTheme file you
want to import, select it, then click the Open button.

To export a Theme:
= Make sure the Theme you want to export is in the active brain tab.

= Click the Export button, navigate to the location where you want to save the
Theme, then click the Save button.

= Click OK in the confirmation box.

Dark Mode

The Dark Mode changes the windows, menus, icons and other user interface

elements to be predominantly dark grey. Dark Mode allows you to focus on your
work with subtle colors and fewer distractions.

e To switch to Dark Mode, click the Options menu, then click the
Preferences command (on macOS, the Preferences command is

located in the TheBrain menu). On the Look and Feel tab, select Dark
under the User Interface setting.

e After you give permission, TheBrain will restart and apply the change.

I Howard + Partners
Inc.

= You may want to modify your Brain Theme to complement the darker
interface and tones.

= On macOS, the Dark Mode setting will follow your OS automatically.
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Setting Other Preferences

TheBrain’s Preferences dialog box is where you'll find many of the settings for
adjusting how your brain works, both mechanically and visually. Preference
settings affect how TheBrain works globally—no matter which brain is open when
you make your choices.

To open the Preferences dialog box:

Click the Options menu, then click the Preferences command (on macOS,

the Preferences command is located in the TheBrain menu)

- Lee Sharpe | Hobbies
AR A&

= My Brain 7 Hobbies

TheBrain Preferences
Look & Feel
Behavior

Notes Editor
System

Keyboard

Experimental

TheBrain 13 User Guide

-
.> File Edit Thought ViewOnIime Window Help

Arrange Thoughts by

Web Search... F4
aA Command Search
Mark Show Forgotten Thoughts aA B
Hide Private Thoughts %E !
Wander Ctrl+Shift+L _
L= ¥

Check Spelling as You Type
Show Markdown

el ]

Brain Theme...
Show TheBrain Preferences window

ol Preferences...
* * Food \

Figure 72. Accessing Preferences

are organized into these categories:
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= Preferences [,} X
Look & Feel
User Interface
[] Compact window title bar
Theme: Light v
Animation
Speed: Fast Slow
Wander delay: (Os) Short Long
Thoughts
Column width: 0% Minimum Maximum
Spacing: Narrow Wide
Tag text: Show on hover +
Tag icons: Show always v

[] Show event indicators
[] Show note indicators

Show siblings in normal view and mapped links

/] Context sensitive thought names
g

[] Show label for active thought
Text shadows

[[] Use ClearType to render text (slower)

Links
Curved links

Timeline

Always show thought or link name on events

[] Calendar week starts on Monday

Figure 73. Look & Feel Preferences

User Interface

Preference

Description

Compact Window Title Bar

Moves the File, Edit, Thought, View, etc.
menu items up into the frame of the app.

Theme Switch between Light and Dark Mode.
Plex
Preference Description

Default Layout:

Select from Normal, Outline, Mind Map or
Normal +1,

Animation Speed

Drag the slider right to reduce or left to
increase the speed with which a thought
becomes active when you click it in the plex.
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Description

Wander Delay

Wandering is an option to step randomly
through TheBrain, to let you see thought
associations. Drag the slider to specify the
amount of delay (in seconds) between
thought activations. The delay is shortest by
default.

Thoughts

Preference Description

Column Width Controls the minimum size that will be used
for columns of thoughts relative to the current
text size.

Spacing Drag the slider to decrease or increase
space between thoughts. The wider the
spacing, the larger and more spaced out the
thoughts will be.

Tags text You can choose not to show, only show Tag
text on hover (mouseover), or always show.

Tags icons You can choose to never show, only show

Tag icons on hover (mouseover), or always
show.

Show events indicators

Event icons will appear in the bottom-right
area of thoughts that include events. This
preference is off by default.

Show notes indicators

Note icons will appear in the bottom-right
area of thoughts that include notes. When
this is selected, you can hover over the icons
for an instant view of the corresponding note.
This preference is off by default.

Show siblings in normal

This preference is on by default.

view
Context sensitive thought Context sensitive thought names are
names explained on page 81. This preference is on

by default.

Show label for active
thought

This preference is off by default.

Text shadows

This preference is on by default.

Use ClearType to render
text (slower)

Applies a crisper display of thought names,
but may require more system resources.
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Description

Curved Links

When selected, links will be curved lines and
when not selected, links will be straight lines.
This preference is on by default.

Timeline

Preference

Description

Always show thought or
link name on events

This preference is on by default.

Calendar week starts on
Monday

When checked, Monday will be the first day
of the week. Unchecked, Sunday will be the
first day.

Behavior Preferences
2>
Behavior

Thoughts
On click active thought:

[] Custom thought context menu

Open properties ¥

Toggle commands

[] Automatically capitalize thoughts on creation

[ Activate last created thought

Download icons for attached email addresses from Gravatar

Content

On drag and drop of files:

Move dropped files  ~

[] Update displayed content on mouse hover or keyboard highlight

[[] Show details when selecting attachment to open
Show first attachment when notes is empty

Show attachments as a list

[ Show attachment modification date and time in list

Content Previews

On click attachment:

Preview when possible ©

Show content previews when searching
Automatically start playback of media attachments
Show page thumbnails in PDF preview

Embedded browser for web links

Preview attachments immediately upon being attached

Other

[ Sync brains on application exit

[] Maximize the plex on double-click of
background and content area on

[] Hide brain name in tabs
[] Treat touches like mouse input z
Show accounts on brains List

double-click of toolbar background

Figure 74. Behavior Preferences
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Description

On click active thought

By default, the thought’s properties will
display when the active thought is clicked.
The other option is to do nothing.

Custom thought Context
Menu

Click on Toggle Commands and uncheck
options that you would like to have hidden.

Automatically capitalize
thoughts on creation

The first letter of the name of the thought will
be automatically capitalized. This preference
is on by default.

Activate last created
thought

A thought will become the active thought as
soon as it’s created. This preference is off by
default.

Download Icons for
Attached Email Addresses
from Gravatar

This preference is on by default.

Content

Preference

Description

On drag and drop of files

Update displayed content
on hover

By default, files will be copied when dragged
and dropped. The other options are that they
will be either moved or linked.

This preference is off by default.

Show details when
selecting attachment to
open

This preference is off by default.

Show first attachment when
notes is empty

Preference is on by default.

Show attachments as a list

Attachments will show in the same area
instead of on separate tabs within the content
area. This preference is off by default.

Show attachment
modification date and time
in list

Will display the file modification date/time
when files are viewed as a list

Content Previews

Preference

Description

On click attachment

Select between ‘Preview when possible’ or
‘Always open in default application’.
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Preference Description
Show content previews This preference is on by default.
when searching
Automatically start This preference is on by default.
playback of media
attachments
Show page thumbnails in This preference is on by default.
PDF preview
Embedded browser for web  Linked web pages will open in TheBrain’s
links built in browser.
Preview attachments Attachments being dragged and dropped into
immediately upon being TheBrain will launch in the content area
attached immediately when checked.
Other
Preference Description

Sync brains on application Closing TheBrain application will sync all
exit brains. To exit immediately when this feature
is on, simply close the sync status window.

Maximize on double-click Double-clicking either the plex or content area

of plex background or background will maximize that part of the

content tab background brain and the other part will be hidden. This
preference is off by default.

Hide brain name in tabs Removes the brain name from appearing in

the tabbed interface.

Treat touches like mouse The way the plex interprets touch events can

input be altered using the preference. More
information on this setting is available at
https://www.thebrain.com/docs/touches-info

Show accounts on brains Display all available accounts below brain
list thumbnails on the brains list tab.
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Notes Editor Preferences

>
Notes Editor
General
Layout: Simple ©
Line Spacing: 12~
Thought Icon: Inline v
Emoji Size: Large -
Attachments text size: Small v
Custom date/time format for notes 2
“MMMM d, yyyy*™
**September 29, 2022**
Animation

Animate cursor
Blink cursor
Highlight lines on hover

Header and Footer
Include title
[ Include label
Mapped links
Backlinks
Unlinked mentions
Hide private backlinks/unlinked mentions

Options
Select adjacent text when inserting link
Automatic smart quotes
Rename thought updates links
[] Check spelling as you type
Recognize emails and phone numbers
Insert link when extracting child thought

Customizing Your Brain’s Environment

Display
Underline normal links
Render underscore tags as italics
[] show markdown

User Interface
[] Use compact toolbars for notes
Show link target in pop-up
Restore cursor and scroll position
Mentioned thought names:
Show all >

Clicking links in notes:

Moves cursor v

Printing
Include title
Include label
[ Include links and mentions
[ Include attachments
Prevent widows and orphans
Prevent orphan headers

Clipboard
Replace pasted URL with page title
[[] Paste without formatting as default
Exclude color information when pasting

Figure 75. Notes Editor Preferences

General
Preference Description
Layout Simple (all notes on one long scrolling page)

or Multi-Column (notes in thinner columns,
multiple columns will be displayed where
space is available)

Line Spacing

Set notes line spacing.

Thought Icon

Choose between Hide, Above, Below, and
Inline—the default icon placement is inline.

Emoji Size

Set emoji size to Small, Medium, or Large.

Attachment Text Size

Set attachment text size to Small, Medium, or
Large.

Custom Date/Time Format

Use the default date/time layout or customize
your own.

TheBrain 13 User Guide

64



Customizing Your Brain’s Environment

Custom date/time format for notes

Use the following format options to customize the appearance of your date/time
stamp in notes:

Characters Result

d The day of the month, from 1 through 31.

dd The day of the month, from 01 through 31.
ddd The abbreviated name of the day of the week.
dddd The full name of the day of the week.

h The hour, using a 12-hour clock from 1 to 12.
hh The hour, using a 12-hour clock from 01 to 12.
H The hour, using a 24-hour clock from 0 to 23.
HH The hour, using a 24-hour clock from 00 to 23.
K Time zone information.

mm The minute, from 00 through 59.

M The month, from 1 through 12.

MM The month, from 01 through 12.

MMM The abbreviated name of the month.

MMMM The full name of the month.

Ss The second, from 00 through 59.

t The first character of the AM/PM designator.

tt The AM/PM designator.

vy The year, from 00 to 99.

yyyy The year as a four-digit number.

z Hours offset from UTC, with no leading zeros.
7z Hours offset from UTC, with a leading zero for a single-digit value.
zzz Hours and minutes offset from UTC.

The time separator.

/ The date separator.
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Description

Animate Cursor

Blink Cursor

Cursor will visibly animate when clicking to
different locations in notes.

Cursor in notes will blink to indicate its
location.

Highlight lines on hover

Hover over any line in the notes and it will be
highlighted.

Header and Footer

Preference

Description

Include Title

This preference is on by default. Option to
display the Thought Label in the content area
when checked.

Mapped Links

This preference is on by default.

Backlinks This preference is on by default.
Unlinked Mentions This preference is on by default.
Hide Private This preference is on by default.
Backlinks/Unlinked
Mentions

Options
Preference Description

Select adjacent text when
inserting link

This preference is on by default.

Automatic smart quotes

This preference is on by default.

Rename thought updates
links

This preference is on by default.

Check spelling as you type

This preference is on by default. Applies to
spell checking while creating thought names
as well.

Recognize emails and
phone numbers

Properly formatted emails and phone
numbers will be hyperlinked.

Insert link when extracting
child thoughts

When selecting text in a note to become a
new thought, a link to the new thought
remains on the original note.
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Description

Underline normal links

Hyperlinked text will be underlined.

Render underscore tags as
italics

Unchecked — text within underscores will be
underlined. Checked — text within
underscores will be italicized.

Show markdown

When checked, markdown tags will be visible
in the notes.

User Interface

Preference

Description

Use compact toolbars for
notes

Some content area buttons will be grouped
into dropdown lists—all tools will be available
via the More Notes Editor Actions button.

Show link target in pop-up

When checked, hovering over a hyperlink in
a note will display the linked URL.

Restore cursor and scroll
position

This preference is on by default.

Mentioned Thought names

Select between Show all, Show except
common words and Never show

Clicking links in notes

Follows link or Moves cursor (places cursor
in the text)

Printing
Preference Description
Include title Includes title when printing the note.
Include label Include any thought label when printing

Include links and mentions

This preference is off by default.

Include attachments

This preference is off by default.

Prevent widows and
orphans

This preference is on by default.

Prevent orphan headers

This preference is on by default.

Clipboard

Preference

Description

Replace pasted URL with
page title

This preference is on by default.
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Preference Description

Paste without formatting as  This preference is off by default.
default

Exclude color information This preference is on by default.
when pasting

System Preferences

> Preferences X
System
Updates
Check for updates on startup: Always v
Update channel Alpha

Localization

Interface Language: Automatic v
Spelling Dictionary: Automatic v
Storage

Brain data is stored in the following location. WARNING: Do not set this to a network share
or to removable media such as a USB drive. Daing so will result in data corruption,

C\Users\mscat\Brains Select Folder

Use default working directory for Import and Sync.

Proxy Settings
[[] Use proxy server

Proxy server requires authentication

Figure 76. System Preferences

Updates
Preference Description
Check for updates on Notification of updates on startup. Always,
startup Only free updates or Never.
Update Channel This preference affects which kind of updates
you'’ll see as available when you click the
Check for Update command on TheBrain’s
Help menu. The default is Stable and the
other choices are Beta and Alpha.
Localization
Preference Description
Interface Language The default is Automatic.
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Description

Spelling Dictionary

The default is Automatic and there are many
other languages to choose from in the drop-
down list. After you select another language,
you’ll be prompted to exit TheBrain and
restart so that your change can take effect.

Storage
Preference Description
Storage The location of your brain data. The default is

to use the default working directory for Import
and Sync.

Proxy Settings

Preference

Description

Use proxy server and proxy
server requires
authentication

If you are unable to synchronize your brain
with TheBrain Cloud due to a proxy server or
restricted ports on your network, the Proxy
settings can be used to customize the
synchronization process. Check with your
network administrator for the appropriate
information for these fields. By default, the
Use proxy server preference is off.

Keyboard Preferences

Most Brain commands can be accessed by keyboard commands, which you can
customize based on your preferences. You can even export your settings to
share them with others or to transfer them from one computer to another.
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=2 Preferences X

Keyboard

P> Application
P Attachments
P> Brain

P Edit

P Link

P Media

P Navigation
P Notes

P> Notes Table
P> Options

b PDF

P> Report

P> Selection

P Thought

P Thought Icon
P Timeline

P View

P Window

Expand All | | Collapse All

Figure 77. Keyboard Preferences

Using the Keyboard Preferences Tab

To do this ... Do this ...

Find a command quickly Begin typing the command in the Search
commands field in the bottom-left corner of the
Keyboard tab of the Preferences window.

a4

WV Attachments
Add Attachment

Copy
Copy in or out of Brain

Copy to Icon
Cut

Dalai

] l Expand All I ICoIIapse Alll

As you type, the list will shorten to match what
you've typed. When you see the command
you’re looking for, note its shortcut or click it to
define a new shortcut.
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To do this ... Do this ...
Collapse the list to see Click the Collapse All button.
only major headings i
WV Attachments
Add Attachment
Copy

Copy in or out of Brain
Copy to Icon
Cut

Dalai

’

I Expand All l

Collapse All ]

You can also collapse an individual heading,
for example “Application,” to collapse or
expand just that section.

Restore the full list Click the Expand All button.

P Application
P> Attachments
P> Brain

P Edit

P Link

P> Navigation
P Notes

P> Options

P> Report

P> Selection

P Thought

P Thought Icon
P Timeline

P View

P Window

IExpand All |  Collapse All

To do this ... Do this ...

Import shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, then click
the Import Shortcuts command.

TheBrain 13 User Guide 71



Customizing Your Brain’s Environment

To do this ... Do this ...

Export shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, click the
Export Shortcuts command, select a
location for the file, then click the OK button.
The file will be named
“KeyboardShortcuts.txt.”

Restore default shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, then click
the Restore Defaults command.

Next Brain Tab Ctri+1ab
Next Content Tab Ctrl+Q
Previous Brain Tab ‘ Shift+Ctrl+Tab
Previous Content Tab Shift+Ctrl+Q
Rotate Splitter Shift+Ctrl+D
Splitter Left or Up Shift+Ctrl+A
Splitter Right or Down Shift+Ctrl+S
Swap Splitter Panes

Import Shortcuts

Export Shortcuts

Expand All | I Collapse All I =
’ Restore Defaults

To define a new shortcut:
1. Inthe left column, expand a category of interest.

2. Click the command for which you want to create a shortcut. The row
containing the command will be highlighted and an instruction will appear
under the Preferences tabs.
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=
Keyboard

Type keyboard shortcut. Esc to cancel. Delete to remove.

Check for any available updates to TheBrain

Application
About
Documentation
Exit
Manage Endpoints...
Perform Data Integrity Scan
Preferences... Ctrl+,
Search Commands and Preferences
Show Account Info
Show Tips
Tutorials
Upgrade Services
Attachments

Brain

Figure 78. Creating a New Shortcut

3. With the command of your choice highlighted, press the function key or
keyboard combination of your choice. For example, you might choose to
assign the “Check for Update” command to Ctrl+Shift+U.

) You can’t assign keys that are already used for common operations (such as
. Ctrl-C) nor can you use letter or number keys by themselves. The Alt key can
be used as a standalone modifier

Your new shortcut will display in the list. You can delete the shortcut by pressing
the Delete key while the command is highlighted.

WV Application
About |
[ Check for Update _ Shift+Ctrl+U ]
Exit ' Alt+F4
Hide Others

Figure 79. The New Shortcut in the List

If the keyboard shortcut you selected is already in use for another action, you will
have the option to “steal” the shortcut for the current selection, or cancel the
request and select a different keyboard combination.
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=2 Key Combination Already in Use X

This key combination is already mapped to Application > Preferences...

| Replace || Cancel

Figure 80. Replacing an Existing Shortcut

il _
Bl Default Shortcuts for Windows

Application Commands Shortcut
Exit Alt+F4
Preferences Ctrl+,
Edit Commands Shortcut
Copy Ctrl+C
Copy as Text Shift+Ctrl+C
Cut Ctrl+X
Paste Ctrl+V
Paste without Formatting Shift+Ctrl+V
Redo Ctrl+Y
Select All Ctrl+A
Undo Ctrl+Z
Navigation Commands Shortcut
Activate Tag Ctrl+G
Activate Type Ctrl+E
Backward Alt+Left
Expand/Collapse Current Thought Space
Forward Alt+Right
Navigate Down Down
Navigate Enter Enter
Navigate Escape Esc
Navigate Left Left
Navigate Right Right
Navigate to Pin 1 Ctrl+1
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Navigation Commands Shortcut
Navigate to Pin 2 Ctrl+2
Navigate to Pin 3 Ctrl+3
Navigate to Pin 4 Ctrl+4
Navigate to Pin 5 Ctrl+5
Navigate to Pin 6 Ctrl+6
Navigate to Pin 7 Ctrl+7
Navigate to Pin 8 Ctrl+8
Navigate Up Up
Notes Commands Shortcut
Bold Ctrl+B
Collapse All Ctrl+[
Collapse All Except Here Shift + Ctrl+l
Expand All Ctrl+]
Expand/Collapse Toggle Ctrl+\
Find & Replace Ctrl+F
Find Next F3

Find Previous Shift+F3
Insert Date/Time Ctrl+D
Insert/Edit Thought or Web Link Ctrl+K
Italic Ctrl+l
Open in Browser Alt+Ctrl+O
Pop up Table of Contents Ctrl+T
Print Ctrl+P
Replace Next Ctrl+F3

Replace Previous

Shift+Ctrl+F3

Take Action Ctrl+L
Underline Ctrl+U
Options Commands Shortcut
Web Search F4
Thought Commands Shortcut
Create Child F6
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Thought Commands Shortcut
Create Jump F8

Create Parent F7

Forget Ctrl+Del
Open Folder Shift+Ctrl+F
Show Thought Properties Ctrl+Enter
Thought Icon Commands Shortcut
Select Stock Icon Alt+Ctrl+l
View Commands Shortcut
Collapse All Ctrl+9
Expand All Ctrl+0

Mind Map Shift+Ctrl+3
Normal Shift+Ctrl+1
Outline Shift+Ctrl+2
Zoom In Ctrl+=
Zoom Out Ctrl+-
Window Commands Shortcut
Close Tab Ctrl+W
Close Window Alt+F4
Keyboard Focus to Notes Ctrl+N
Keyboard Focus to Search Ctrl+S

New Tab Ctrl+T

New Window Shift+Ctrl+N
Next Brain Tab Ctrl+Tab

Previous Brain Tab

Shift+Ctrl+Tab

Rotate Splitter

Shift+Ctrl+D

Splitter Left or Up

Shift+Ctrl+A

Splitter Right or Down

Shift+Ctrl+S
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s
‘ Default Shortcuts for macOS

Create Child Alt+Command+Down
Create Parent Alt+Command+Up
Create Jump Alt+Command+Left
Rename Alt+Enter

Focus on Plex Cmd+S

Focus on notes Cmd+N

Search Web Cmd+E

Experimental Preferences

=2 Preferences X

Experimental

Overview

The features and settings here are experimental in nature and may be removed in future versions.

Troubleshooting
These troubleshooting settings should not be altered unless specifically directed to do so.
[[] Disable hardware rendering

I areas of the display fail to update, try disabling hardware rendering. When this setting is
selected, performance will decrease. We recommend contacting your hardware vendor
for an updated driver.

[] Disable to do list

Disabling the to do list may improve startup performance.

Figure 81. Experimental Preferences

The features and settings on the Experimental tab will change from time to time
and may be removed in future versions of TheBrain.
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Creating Thoughts

Creating a Single Thought

There are many ways to create a thought, but most start with the same step—
choosing the thought with which the new thought will have a relationship. You will
use the chosen thought as a starting place when creating the new thought.

Generally speaking, you'll create child thoughts more often than parents or
jumps. There are certainly exceptions, but usually, using a “top-down” approach
is helpful if you are just getting started: Create children (and jumps, as
appropriate) and let parents happen naturally.

Once you have activated the thought that will have a relationship with your new
thought, use any of these techniques to begin creating a new thought:

= Drag from the thought’s parent, child, or jump gate

Drag from here

to create a
Drag from here parent thought
to create a ‘
jump thought -
——-— Drag from here
> 'to create a

child thought
I

Figure 82. Gates to Drag for Creating Thoughts

= Orclick the Thought menu, then click the Create Child, Create Parent, or
Create Jump command

‘) File Edit | Thought | View Options Online Window Help

Create Child n F6

One Brain fg ? RS .
Create| Create a child thought 7

f 2

Create Jump F8
j

= Or, right-click the thought, then click the Create Child, Create Parent, or
Create Jump command
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—
o&CustoLner
” Open in New Tab
¢ Clients b
; Open in New Window
| CreateChild |\ F6
Create Parent E7
Create Jump Create a child Thought

= Oruse a keyboard shortcut:

mll On Windows, press the F6 key (for a child thought), F7 (for a parent
M thought), or F8 (for a jump thought)

#_  On macOS, press the Option+Cmd+Down Arrow (for a child
’ thought), Option+Cmd+Up Arrow (for a parent thought), or
Option+Cmd+Left Arrow (for a jump thought)

No matter which of the above methods you use to begin creating your new
thought, the next thing you'll see is the Thought Creation dialog box with the
cursor blinking in the field for typing in the name of your new thought.

Type a Thought
name here

XYZ4

-

Figure 83. Thought Creation Dialog Box
1. Type the name of your new thought in the field provided.

2. Press the Enter key or click in a blank area of the plex to save your new
thought (or press the Esc key to cancel the process and close the box).

Automatic initial-capitalization: If you type a thought name using all
lowercase letters, the first letters of words will be capitalized for you
automatically. TheBrain uses “smart rules” to determine which words should be
lowercase (such as “a,” “and,” and “of”). For example, if you've typed “visit the
) statue of liberty” the thought name will automatically become “Visit the Statue
8 of Liberty.” This feature is active, by default, but you can turn it off in the
Behavior tab of the Preferences dialog box.

If spellcheck is turned on in the content area toolbar, thought names will also
be spelichecked in the Thought Creation dialog box as well as in the
Thought Properties dialog box.
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Displaying Thought Properties and Details

= To expand the thought creation box to include the Type and Tags buttons
(explained in the Thought Types and Tags section beginning on page 118),
click the down-arrow in the bottom-right corner

= To display a thought’s details (create/modify dates and ID) after the thought is
created, click the down-arrow in the bottom-right corner

= To hide the thought’s detalils, click the up-arrow in the bottom-right corner

1[@ Clients|

Click to expand

, G~
ABC L 3
/ o'
-}
lhBC L Il
& Click to expand

‘ Type Tags

Created: Today, 8:14:47 AM
Modified Today, 8:14:47 AM

b

ID: dcb48965-8093-40bb-b6a4-246b0b6f05d 1 Click to co"apse

4/

Figure 84. Showing and Hiding Thought Properties and Details

Creating Multiple Thoughts at Once

TheBrain offers a timesaver (affectionately known as the “semi-colon trick”) for
creating more than one thought at a time.

= Type a semicolon () to separate multiple thought names in the Thought
Creation dialog box

= This feature can also be used while creating new Thought Types and
Thought Tags
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[ ABC:YetCo:New GuysiTriedNTru )
o4 Meeg
4 new (@ Clents Sty
children — 5 v
created at the 7 e
same time { \
oABC oNew Guys
o Bes’c YgtCo cTriéderu

Figure 85. Creating Multiple Thoughts

Creating Context-Sensitive Thought Names Using Commas

I's always good to be specific with your thought names. TheBrain has some time
savers to help you if you have repetitive information that needs to be added to
your brain. For example, say you have thoughts for each of your clients, each of
whom has a billing department. You'd like a child thought named “Billing Info” for
each of your client thoughts. However, you may not want to have identical
thought names because when you see these thoughts later you won’t be able to
tell them apart without looking at their parents.

To remedy this potential dilemma, when you type the name of the new thought,
start or end the name with a comma. The parent thought name will be added
automatically. When this thought is displayed, its name will vary depending on
the context in which it's viewed. If the client thought is active, the client’'s name
will be hidden and it will appear as just “Billing Info.” But when you activate this
thought, the full name along with the client’'s name will appear.
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- @ R
?New Guys |

{comma
@illing Info>
When this is entered ... | ‘

... it appears as this

1]
New G.uys ”Bllll?\glnfo oNew G.uys
| ... except when the
( New Guys, Billing Info E’ Thought is active 4
* Actual name in = —» \fNew Guys, Billing Info]
N J - >
Thought Properties
s X g f [ p Tags

—

Type
Modified:  Today, 8:32:59 AM

Created: Today, 8:32:59 AM
1D: 33f4d395-0d70-4bc1-9a8b-65a4e687362e

-

Figure 86. Sub-Category Thoughts

The thought will display its full name when it is active or when hovering over it
with the cursor. When its parent thought is active, you’ll see only the portion of
the name that does not repeat the parent’'s name. Ensuring that each of your
thoughts has a unique name will help you find and identify them more easily.

Tip: The part of the thought’s name that is hidden is context sensitive. Say for
example that you wanted to have a single place to see the billing information for
all your clients. You might create a thought called “Billing Info” and then link to
the billing information thoughts for each of your clients, such as “New Guys,
Billing Info.” If you do this, when Billing Info is active “New Guys, Billing Info” will
appear as just “New Guys,” whereas when New Guys is active, that same
thought will appear as Billing Info. Try it—you’ll see how this can be very useful.
When thoughts are displayed in alphabetical order, the current view of the
context sensitive name will determine its position.

Using Parentheses to Assist with Thought Sorting

Adding parentheses around the first part of thought name will skip that part for
sorting purposes (unless there is a tie) when thoughts are grouped
alphabetically.

= To enable this feature, a thought name must have both an open parenthesis
as the first character and a close parenthesis later in the thought name.
Whitespace will be trimmed, and there must be some thought name left after
that. (Later parenthesis will be ignored.)
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= Note that this is mutually exclusive to Hidden Ordering Prefixes starting with a
dot. You can only have one or the other.

Example: if your thoughts are grouped alphabetically, the following group of
thoughts named:

(The) Beatles
Belle & Sebastian
(The) Bee Gees
(The) Beach Boys

would display as:

The Beach Boys
The Beatles

The Bee Gees
Belle & Sebastian

Creating Orphan Thoughts

When you create a thought in your brain, you usually first decide what
relationship it will have with an existing thought, but sometimes you just want to
create a thought unrelated to an existing thought.

To create a thought independently of other thoughts, type into the Search box. If
no search result is returned, hit enter and the new thought will be created as an
Orphan. This works well especially when you are looking for something and
discover you haven'’t yet put it into your brain.

Tip: You can also create an orphan thought by pressing F9 on Windows or
Opt+Cmd+Right Arrow on macOS.

LUPY L WD Lpuudnu

Create Child F6
Create Jump F8
Create Orphan F9
Create Parent F7
Craata Thanaht el LM

Figure 87. Default Windows Keyboard Shortcut for Create Orphan

Create Thoughts from Search, Notes or Events

You can create a new thought instantly from the Search box or within Notes or
Events. Say you’d like a “Monthly Meetings” thought to be a child of “My Work,”
but you're not sure whether you already have a thought with that name. You can
begin by searching, and if it doesn’t already exist, no need to retype the name.
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To create a new thought using search:

1. Activate the thought that should be the parent, child, or jump thought of the
new thought.

2. Click in the Search box at the top-right corner of the window, then type the
name of the thought you’re looking for, or want to create if it's not found.

3. If the thought doesn’t already exist and you want to create it:
o Press the Enter key to create it as a child of the active thought, or

¢ Hold down the Shift key as you press the Enter key to create it as a
parent of the active thought, or

¢ Hold down the Ctrl key as you press the Enter key to create it as a jump
thought of the active thought, or

¢ Hold down the Ctrl key as you press the Shift key, then click on Create
Orphan to create it as an orphan thought

Your new thought will be the active thought.

ws | B | monthly meetings

0 matches [] Childward only |=

Figure 88. Creating a Thought from the Search Box
To create a new thought when searching finds an existing thought:

1. Press the up-arrow key. This highlights the default option—Create Child.
Note that pressing the Enter key before pressing the up-arrow key
activates the existing thought.

= [0 | monthly meeting

[] Childward only =

A N

Thoughts, Links and Events
Monthly Meetings
Notes and Internal Attachments

M = My wWork

Monthly Meetings
Figure 89. Creating a Thought from the Search Box when the Thought is Found
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2. Use any of the same key combinations for creating a new thought from the
Search box when a thought isn’t found.

To create a new thought from within a note:

1. Select the text within the note for which you want to create a child, parent,
or jump thought.

2. Right-click the selected text, then click the Insert Thought or Web Link
command. Optionally, you can revise the text in the new box that appears,
if you want a different name for the new thought.

3. Select a relationship for the new thought:
e Press the Enter key to create it as a child of the active thought, or

¢ Hold down the Shift key as you press the Enter key to create it as a
parent of the active thought, or

¢ Hold down the Ctrl key as you press the Enter key to create it as a jump
thought of the active thought

My Work

Rev up monthly meetinas for clients comina in next week
Inﬁﬁ Thought or Web Link Ctrl+K

Collap A B 7 F v @ =
My Work EXpan =
Collap
My Work

Rev up monthly meetings for clients coming in next week

monthly meetings

ey wwwaan

7 Mapped Links
Figure 90. Creating a Thought from a Note
To create a new thought from within an Event:

1. Open an existing Event or click and drag from the start to finish times in the
timeline to create a new Event.

2. Type a name for the new thought where you see “No thought or link” at the
top of the Event box. A new orphan thought will be created with that name.
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om- wnat |

o ‘Nc thought or link N ] = . is to relax
L]
3/25/2021 5:00 PM to 3/25/2021 6:00 PM
om¢ ¥/%/ ° 132/ g Tabs
[[] Al Day [[] Reminder =
Hom My Brain  Per
Qﬁ/l'.l' jay, March 25, 5:00 PM = 6:00 PM
&
[ I | | | |
24, 2021 Thu, Mar 25, 2021 Fri, Mar 26, 2021 Sat, Mar 27, 2021

Figure 91. Creating a Thought from an Event

Changing the Order of thoughts in the Plex

You can use TheBrain’s hidden ordering system to change the default
alphabetical ordering of thoughts in the plex to any order you prefer. To do this,
type a period and a number as the first characters of any thought name. These
characters will not be displayed in the plex. For example, try creating the
following group of child thoughts in one area:

= 01 Zebra
= .02 Walrus
= 03 Aardvark

The thoughts will appear in the order of Zebra, Walrus, Aardvark (without the
periods or numbers), rather than alphabetically. You can always delete or revise
the numbers in the Thought Properties dialog box.

|
——® Before inserting
{New Pet Ideas) hidden numbers

—
{New Pet Ideas |
b : — Zebga
After inserting .| \Valrus
(o]

hidden numbers A

Kargvark

Figure 92. Changing Thought Order
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Copying Thoughts Within and Between Brains

Thoughts, including all of their notes, properties, events, and attachments, can
be copied and pasted between brains or duplicated within a brain. When
thoughts are copied, associated thought types and link types are automatically
copied as well.

To copy a thought within the same brain:

1. Right-click the thought to be copied and then click the Copy “name of
thought” command on the context menu.

Open in New Window

] . ‘
o' My Passio Create Child F6
* Create Parent F7
Create Jump F8
Set Type 4

Set Tags 4

@
$Restaurant s ascomen

Create Event

Paste

Open Thought Folder Ctrl+Shift+F

Select Stock Icon Ctrl+Alt+I
Capture Image

Paste Icon

l Copy "Restaurants”
Copy Local Thought URL | Copy this Thought

Copy Web Thought URL

2. Activate the thought that will be the parent of the newly copied thought.

3. Right-click within any blank area of the plex and click Paste Thought(s) on
the context menu.

® ®
o0& Hob.bies

@
. PY )
CE' My P§55|0n] o Home.PrOJ...
[~ ] .
0¥ My.Pet
[ ]
o#1Pat Green
I Paste Thought || o)
. -
(@ BOOkS Arr% Create a new thought or thoughts from the content of the clipboard
© Layout 4 v
Expand All Ctrl+0
Collapse All

4. The copied thought will automatically be linked as a child of the active
thought and it will also retain all of its original relationships.
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0_".”I’=amiTy a.nd Fri...

) oy
o4 Personal Life

=
NS

) Heal.1_:hl.and Fi...

$® My Passion Hoallh | @

/Bon Hobbi 5 "
/ Me~| @2 Food o® My Pe;ssion

~—

_— ) |

&, _— Copied “—m —————=—~
oBooks Thought b
/ now haSK-b

2 parLents

I

Figure 93. Copied Thought with Two Parents

o
o Restaugants

To create a duplicate of a thought:

If you just want to make a duplicate of a single thought without retaining any of its
links, you can use the Duplicate Thought command.

1. Right-click the thought to be duplicated and then click the Duplicate
Thought command on the context menu.

2. The duplicated thought will appear as a child of the original, as shown in the

figure below.
= Copy Cocar Tougnt URC
oW My Pass| Copy Web Thought URL
N Copy Path to Thought's Folder
/ \ =
Original v Duplicatg Thought |

Thought | Forget " L

Create a duplicate of the selected Thought as a child I
\» <€BOOkS Create Piry

Set as Home Thought

[ ]
o®@ My Passion
| &

S

Original /

Thought | 2

> ook
/,‘

Duplicate
Thought |

\-b o Bé)olés

Figure 94. Duplicating a Thought
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To copy athought to another brain:

1. Right-click the thought to be copied and then click the Copy “thought
name” command on the context menu (or activate the thought, click the
Edit menu, and then click the Copy command).

Open the brain into which you want to copy the thought.

Right-click on the background of the plex and then click the Paste Thought
command on the context menu (or click the Edit menu and then click the
Paste Thought command).

4. The thought will be pasted into the brain and linked as a child of the active
thought. It will include any attachments, thought types, notes, or other
attributes it had in the original brain.

If you have selected multiple thoughts, they can all be copied at once using the
) same technique. Right-click anyplace within the Selection panel to open the
: context menu. See Selecting Multiple Thoughts beginning on page 92 for
complete instructions about selecting multiple thoughts.

Paste Thought Colors:

1. Right-click on any thought with modified colors (text or background) and
select Copy “thought name”

2. Right click on another thought (in the same brain or a different brain) and
select Paste Thought Colors. This thought will then have the same text
and background colors as the thought that was originally copied. This
feature can also be used when working with multiple thoughts in the
Selection Box.

Merging Thoughts

You can automatically merge multiple thoughts that refer to the same thing. You
can combine the links, attachments, and notes so that the resulting thought has
all of the information from those multiple thoughts.

To merge thoughts:

1. Citrl+click on two or more thoughts that you want to merge into a single
thought. The thought names will automatically appear in the Selection
panel.

2. Right-click in the Selection panel, then click Merge (n) Thoughts.
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Selected (3) ® &Goals
Grover Park

Library

Venice Beach
‘r

1 o
Copy 3 Thoughts oPersonal Life
Copy as Text Outline

Copy as Text Outline with Notes

Create Document... =) TOp EI‘
— A N
| Merge 3 Thoughts . @) Places to relax]  oHomeow
Forget 3 Tho| Merge 3 thoughts o USIF.\ Ta
I —— 93
oGrover Park i {Venice Beach}

“{lbrary:

Figure 95. Merging Three Selected Thoughts into One

When you activate the new thought, you’ll see all content that was in each of the
standalone thoughts. The name of the new thought becomes a combination of
the formerly separate thoughts, in alphabetical order.

Library
Grover Park

Best park ever - great place for the nex
wants to have a meeting there.

Venice Beach

Perfect for a relaxing aftemnoon - have to remember to bring plenty of sunscreen though - and
snacks!

Figure 96. Original Content Area of Three Thoughts before Merging
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R Goals A TN B/UTSAEFAEiE0==E=E=
SHEQEME Y 2P x@
Grover Park, Library, Venice Beach
Best p: great place for the next picnic. Also has tennis courts and a carousel! See if the HOA wants to have a
° T g th
o@ Places to relax
L 2
{ Grover Park, Library, Venice...|
Perfect for a relaxing aftemoon - have to remember to bring plenty of sunscreen though - and snacks!
!
1
> Homeowners As... Personal Life My Work # Volunteer Oppor... Grover Park, Librar... g

Figure 97. After Merging

Undoing and Redoing Actions

Changing your mind about your actions is easy. You can undo up to 100 actions
during your current session. Actions that have been undone can also be re-
executed using the Redo command.

') File [ Edit Thought View Options Online Window Help

_IOne B’ Undo % > Undo Remove Link Ctrl+Z
Redo trl+Y Undo Create Thought
<« A
Cut Ctri+X Undo Create Thought
4 Person; Copy Ctil+C | Undo Forget "My Pet”

Copy Local Thought URL
Copy Web Thought URL
Duplicate Thought

0 :
,Jane’s Brain
e O

Figure 98. Undo and Redo Commands

To undo an action:

1. Click the Edit menu and then click the Undo command. The list on the
secondary menu displays your most recent action first.

2. To undo your most recent action, click the first item in the secondary menu.
To undo multiple actions, select the oldest action to be undone from the list.
All actions above that action will also be undone.

To redo an action you have undone:

1. Click the Edit menu and then click the Redo command. If there are multiple
items that can be redone, a secondary menu will be displayed.
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2. Click the action of your choice. As in the list of actions that can be undone,
the list is in most-recent-action-first order. All actions above the item you
click will also be undone.

The Undo and Redo lists are cleared when you sync your brain (including an
auto sync) and when your brain is closed.

Editing Thoughts and Links

Renaming Thoughts

You can easily rename any thought in its Thought Properties dialog box.When
you rename a thought, any references to it from other notes are automatically
updated with the new name.

= Click the thought to make it active, then click it again. You may also click the
Show Thought Properties command in the Thought menu or Alt-click a
non-active thought. In the Thought Properties dialog box, make any edits
you want, then press the Enter key or click in the plex.

oNew f’et.ldeas

o Aa:r*l\/a rk

~ Eat-Tiger A
‘ 4

Type Tags

Figure 99. Renaming a Thought
Selecting Multiple Thoughts
You can select multiple thoughts in three ways:

e Hold down the Ctrl key (Cmd on macOS) as you click each thought you want
to select, or

= Hold down the Ctrl key (Cmd on macOS) as you drag to form a box around
the thoughts, or
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= Hold down the Ctrl key (Cmd on macOS) as you click a gate to select all the
thoughts connected to that gate

—
oMy Br’eln .

— e 'OJ Goals

@’Company Goalse—— e ofIm Mostlntereste ”
3 My Team- — > Personal Life

e \ e o What I'm Thlnklng :

b g e N L N T

i ', Project Management Meetlng Management E

| ol Business. Development Rl Operat|ons !

i L] Cllents , Product’ Development |

E o Customer Service ° ;Sales E

i ° Marketmg E

e e e e e e o e o s e s . S ) i s e h

Figure 100. Selecting Multiple Thoughts by Ctrl-Dragging (Cmd-dragging on
macOS)

, Selected thoughts are then added to TheBrain’s Selection panel for making
. mass edits on large groups of thoughts at one time.

After the multiple thoughts are selected, you can apply actions—Iink, unlink,
forget, set thought type, and other actions you would apply to an individual
thought—to the selected thoughts en masse. When multiple thoughts are
selected, they are listed in a Selection panel on the left side of the plex and they
are highlighted in the plex itself.

4 Personal Life @My Work

£ Bob Jones
tjeCher Wilson
» Dan Brown

Selection

2 Family.an.d Friends
Panel

(Ffiepds] s haniy

___________________

%{g Cher WI|50n' O's Debble Mlller

| e

Figure 101. Selection Panel and Selected Thoughts

TheBrain 13 User Guide 93



Editing Thoughts and Links

To de-select individual thoughts:

= Hold down the Ctrl key (Cmd on macOS) as you click a thought (either in the
plex or in the Selection panel) to de-select just that thought.

To close the Selection panel and de-select all thoughts:

= Click the Close button (X) in the top-right corner of the Selection panel. The
button will turn red as you point to it and after the panel is closed the thoughts
will no longer be selected in the plex.

) Selected (3) ﬁ} |2 Personal Life
& Bob Jones

5i¢ Cher Wilson
®» Dan Brown

Figure 102. Closing the Selection Panel
To perform actions on selected thoughts:

= Right-click in an empty area of the Selection panel and select the action of
your choice on the context menu. The entries in this menu are also displayed
in the Edit menu.
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Forget 3 Thoughts

Set Selection Tags

Set Selection Privacy

Unlink Selection
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Ié Copy 3 Thoughts Ctrl+C
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Copy as Text Outline ri¢

Copy as Text Outline with Notes -

%

Set Selection Thought Type

Link Selection as Children of "Friends"
Link Selection as Parents of “Friends"

Link Selection as Jumps of “Friends"

Show Common Children

Select Path Between

Figure 103. Selection Panel Context Menu

Other Selection Uses

Once you have created a selection, you can also use it for other things besides
what you see in the menu. For example, you can limit searches to selected
thoughts. In the example below, only “Debbie Miller” is found because it is the
only thought name beginning with “D” that is currently selected.

.> File Edit Thought View Options Online Window Help

L ee Sharpe | Friends

O AR 2 A At

Selected (3) ® & 1match

ﬁ Bob JO"_'ES =+ Create Parent

4 Cher Wilson Thoughts, Links and Events
« Debbie Miller

=

a

X
=B
A |d (]

%Select\on only [] Childward only | = |

] Limit results to thoughts that are currently selected |

* Debbie Miller

lone !I
3 Bob Jones|
1

¢4 Cher Wilson

/

% Friends|

o % Family
e ®
oW My.Pet

o ™ Dan Brown

Figure 104. Limiting Searches to Selected Thoughts
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When you no longer need a thought, it can be forgotten or deleted. A forgotten
thought may be remembered and restored later, or deleted. A deleted thought is
gone forever. This is similar to the Recycle Bin/Trash feature on your desktop
which stores your deleted files until you choose to remove them permanently.

To forget a thought:

= Right-click the thought to be forgotten, then click Forget Thought Name in
the context menu, or

= Click the active thought to be forgotten, click the menu button in the Thought
Properties dialog box, then, click the Forget Thought Name command.

oNew f’et}ldeas

My Brain

—
—— oAarduarlk

1

Type ‘ ‘

Created: Today, 4:59:00 PM
Modified:  Today, 4:59:00 PM

ID: 61b76d64-1d70-4272-805e-6d3662f9973a

aClients TriedNTru New Pet Ideas Cat

of B

wj =

Add Attachment
Create Event

Open Thought Folder Ctrl+Shift+F

Copy "Cat"

Copy Local Thought URL
Copy Web Thought URL

Copy Path to Thought's Folder
Duplicate Thought

Forget "Cat" . Ctrl+Del

Show History | £qget this Thought
Switch Name and Labe

Create Pin

Set as Home Thought

Convert to Type or Tag...

Figure 105. Forgetting a Thought in its Thought Properties Dialog Box

Once a thought has been forgotten it will disappear from the display. If you want
to access it again later temporarily, you can do so by turning on the display of
forgotten thoughts. You can also permanently delete forgotten thoughts or you
can remember them.

To access forgotten thoughts:

1. Click the Options menu, then click the Show Forgotten Thoughts
command. Any forgotten thoughts will appear grayed out in the plex.
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Figure 106. Forgotten Thoughts in the Plex

2. Notice the “Showing Forgotten Thoughts” message above the pins. This
reminds you why some thoughts are grayed. You can use forgotten
thoughts just like normal thoughts as long as they are displayed. Click the
View Report button to work directly with the forgotten thoughts.

ow Help = O X
<, .
/ot
= 0o
View Report { Report
Thoughts: | Forgotten v | Reset |
Time: [ Any
Search:
Access: All v
> Sort: Attachments Size vi @ =
o@l Goals
o e
o@p!'m Most |...
e ©
Abo...| ©% My Latest ...
o o
o MyWork
- < ® .
o g, Personal Life
o
Sale
Talent Express
Travel

Figure 107. Forgotten Thoughts in the Report Tab

3. You can click on a thought in the Reports tab to activate it.
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To delete all forgotten thoughts using the Reports tab:

= Click the Reports tab menu button, then select Forgotten from the Thoughts
drop down menu. You can then click on the context menu button and select
Delete Forgotten Thoughts. Alternatively, you can use the Ctrl key (Cmd
on macOS) to select multiple individual forgotten thoughts and then delete

only those.
Report
Thoughts: Forgotten v
Time: Any
Search:
Access: Al Reports tab
~ —— Mmenu button

Sort: Attachments Size v O = e

Add All to Selection V

Remove All from Selection

[ Delete Forgotten Thoughts
7 Remember Forgotten Thoughts
Save as...
Saved Reports 4

Figure 108. Using the Report Tab to Delete All Forgotten Thoughts

= You can click the Refresh button on the Reports tab to update the list.

Closing the Forgotten Thoughts dialog box hides the forgotten thoughts. You
can also reinstate forgotten thoughts by clicking the Remember All command
, in the Reports tab menu. You can also reinstate an individual forgotten
: thought by right-clicking in the plex, then clicking the Remember thought name
command on the context menu.

It is generally recommended to forget thoughts when you don’t need them so that
you can easily retrieve them if you change your mind. If you are sure you will
never need a thought again and you do not want to be able to remember it in the
future, you can delete it immediately without forgetting it first.

To delete a thought instantly:

1. Hold down the Shift key (for Windows)/Alt key (for Mac) as you right-click
the thought to be deleted. The context menu will be displayed, showing the
Delete thought name command in place of the Forget thought name
command.
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Duplicate Thought

Delete "Dinner” [

Create Pin -
Delete this Thought
Set as Home Triougrit

Private

o What I'm Tthking

Show History
Show Thought Properties

{inner)

Figure 109. Shift-Right-Click Context Menu for a Thought

2. Click the Delete thought name command. The thought will be permanently
deleted. See Selecting Multiple Thoughts on page 92 for forgetting or
deleting multiple thoughts at once.

in case the delete needs to be undone. When undo is cleared, the trash is
emptied. The files are then moved to the OS trash/recycle bin so you have
further opportunity to recover the file if needed.

/ When a file attachment is deleted, the file is placed into an internal trash folder

Tip: If you delete something by accident you can still recover it if you use the
Undo command immediately.

Unlinking Thoughts
To unlink thoughts:

= Right-click the link, then click the Unlink command on the context menu

)

Tip: If you are moving a thought from one place to another by linking and
unlinking it, it is generally easier to do the unlinking after you have done the
linking. This avoids making the thought into an “orphan,” a thought with no
relatives.

If you have difficulty telling which link you are pointing at with the mouse, just
look at the highlighted thoughts. When the mouse pointer is over a link, it is
highlighted along with the two thoughts it connects. This makes it easy to tell
which thoughts will be unlinked if you click on the link.
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In addition to being able to unlink thoughts one link at a time, you can also select
multiple thoughts to unlink several of them at once. To do so:

= Select the thoughts you want to unlink by holding down the Ctrl key (Cmd on
macOS) and clicking on each one, or Ctrl drag (Cmd drag on macOS) a box
around thoughts in the same area

= Activate the thought from which you wish to unlink the selected thoughts

= Right-click in the Selection panel and select the Unlink Selection command

Linking Thoughts

As noted previously, links are power. Not only do links allow for associations that
group thoughts conceptually, they allow information to be stored in and
accessible from numerous places.

A single thought may have relationships with multiple thoughts. For example,
you may want a thought named “Aunt Mary” to be a child of your “Mentors”
thought and also a child of your “Family” thought. If your Aunt Mary is also
helping you plan your next vacation, her thought may also be a child or jump
thought to your “Vacation” thought. The possibilities are endless.

There are several ways to link to existing thoughts, as described in the following
sections.

Link to a Thought Visible in the Plex

When the thoughts you want to link are both visible in the plex, you can simply
drag from the desired gate of one thought in the plex to another thought in the
plex. Note that the thought you drag from or to does not have to be the active
thought.

In the Normal view, the display of thoughts is limited to close relations. You may
find it useful to expand the view when linking thoughts, because you can see
more thoughts at once.

Link by Dragging to a Pin

You can Link to a thought that is not visible in the plex if it has a pin. Simply drag
from the appropriate gate to the pin. When you want to link a thought to many
other thoughts, create a pin of the thought so you can quickly link to it. A pin’s
gates appear when you point at the pin with the mouse.

TheBrain 13 User Guide 100



Editing Thoughts and Links
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Figure 110. Link by Dragging to a Pin

The relationship you establish by linking a thought to a pin is between the
thoughts; if you delete the pin, the Link between the thoughts is still intact.

Link by Dragging to the Past Thoughts’ List

You can link a thought in the plex to a thought in the Past Thought List. Like pins,
gates for a thought in the Past Thought List appear when you point at the past
thought with the mouse.

A
< > W ¢4 Upcgening Trip Plans) ‘
>~ -~

Figure 111. Link by Dragging to a Thought in the Past Thoughts’ List
Link by Selecting a Thought in the Existing Thoughts List
You can also link by using the Thought Creation dialog box:

1. Make the thought you want to link from the active thought, then start
creating a thought by dragging or using the Thought menu. The Thought
Creation dialog box appears.
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Type the first few letters of the name of the thought you want to link to.

Double-click on the thought you want to link when you see it in the Existing
Thought List that appears below (or click it once, then click in the thought

name field and press the Enter key).

¢ Upcom"'mg\T rip Plans|
\//

I Type l [ Tags ]

- Upcomln% Urban Travel r Bills

Urgent
: Held Up Project

Figure 112. Create a Link by Starting to Create a Child Thought

Link by Using the Selection Panel

Thoughts in the Selection panel can be linked to the active thought using the

Selection menu:

1.

TheBrain 13 User Guide

Select the thought or thoughts you want to link using Ctrl-click (Cmd on

macOS) or by holding down the Ctrl key (Cmd on macOS) as you drag a

box around the thoughts if they’re next to each other.

Activate the thought in the plex to which you want to link.

Right-click the Selection panel, then click the link command of your choice

in the context menu.
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Figure 113. Linking Using the Selection Panel

Cancel Creation of a Link

Press the Esc key while dragging a link to abort the process. (The mouse button
should still be held down while you press Esc.)

Changing Relationships Using Drag and Drop

Say that you decide that your “Product Promotions” thought shouldn’t really be a

child of your “Customer Service” thought. Instead, it should be the child of
“Business Development.” You can quickly change relationships between
thoughts in a single step: Hold down the Shift key while linking a thought to a
new parent. All of the current parents will be unlinked automatically. Note that
even if a thought has more than one parent, all of the former parents will be
unlinked.
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Figure 114. Shift-Dragging to Change Relationships
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Customizing Thought and Link Properties

."/

You can change the colors of thoughts and links globally using the Brain

Theme dialog box (see the Customizing a Brain’s Appearance section on page
39). This section explains how to view and manage the properties of individual
and selected thoughts and links. Changed settings override the global defaults.

Changing the Properties of a Thought

To open the Thought Properties dialog box, use any of these methods:
= Click the active thought, or

= Click the thought once to select it, then a second time to open the box, or
= Alt-click the thought (whether or not the thought is active), or

= Right-click the thought, then click Show Thought Properties on the context
menu, or

= Click the thought to select it, click the Thought menu in the menu bar, then
click the Show Thought Properties command

Thought Thought name Thought label Text/
icon
% background
N , - W ek
¢ Public/private

Thought_—l_/v pe [ Togs = 4~ Actions menu

type ("Created. Miay 20, 2013, 23624 PM
Modified:  Jul 13, 2018, 7:33:37 PM Thought tags
L ID: b0525c63-90ch-53de-92da-23979730b8a0 Z4~history

w____ Thought details N
Figure 115. Thought Properties Dialog Box

Press the Enter key or click anywhere outside of the dialog box to close it and
save any changes.

You can use the Thought Properties dialog box to:
= Rename a thought

= Add or edit a thought Label

= Add or change a thought Type

= Add or change a thought Tag
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= Mark the thought as Private or Public

= Customize the thought text or background color (just this thought; global
changes are done in the Themes window)

= Add or change the thought's icon

= Review the thought's creation/modification history and ID. The ID is not
normally needed but may be useful when troubleshooting.

= And, using the Thought Properties Actions Menu button (three horizontal
lines):

o Forget the thought
o Create a Pin
o Set as the Home thought

Changing the Colors of a Thought

While thought colors are set globally in the Brain Theme box, you can override
these settings for individual thoughts. To begin, activate the thought, then click
on it or Alt-click on any inactive thought.

Note that the individual changes you may make to thoughts, such as their color
and background, override the settings in the Brain Theme box.

To change the text color of a thought:

= |n the Thought Properties box, click the upper color square, click the color of
your choice, then click outside of the box of colors.

ol .Go_als oL Retire.me.nt Plan... .
) BusinessOGoaIs
o Database Mapping ...
— x
Retiring at 50 &
*

| |

Created: May 20, 2013, 6:37:53 PM
Modified Mar 8, 2019, 4:13:56 PM
ID: 6434de9b-9483-5467-965c-253dbdc84e10

I:‘ Custom . Default
[
Figure 116. Text Color in the Thought Properties Dialog Box
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To change the background color of a thought:

Click the lower color square, click the color of your choice, then click outside
of the box of colors.

ol .Go.als oX Retire'me.nt Plan... .
o BusinessOGoaIs
oDatabase Mapping ...
I;i
-— -
gy p

| |
Created: May 20, 2013, 6:37:53 PM

Modified Mar 8, 2019, 4:13:56 PM

1D: 6434de9b-9483-5467-965¢-253dbdc84e10

. Custom I:‘ Default
4l
Figure 117. Background Color in the Thought Properties Dialog Box

To swap athought’s text color with its background color:

Click the double-headed arrow next to the two color sample squares in the
top-right area of the Thought Properties dialog box.

| S Reiiingatso Y
-—v | -—w
o'
’ Type H Tags ‘E
| i

Figure 118. Swapping Text and Background Colors

You can use the same techniques to fine-tune new colors for thought text and
background as you can use to define colors globally in the Brain Theme box.

. Please see the Defining and Selecting Additional Colors section on page 42 for
details.

Adding a Label to a Thought

Labels are hints that appear below thoughts when you point the mouse at the
thought.
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Figure 119. A Thought Label

To add a label during thought creation:

1. While typing a new thought name, add a pipe symbol (|) and anything after
will become the thought'’s label.

Open New Office | Phoenix

Type | Tags

Figure 120. Adding a Pipe Symbol During Thought Naming
To add a label to an existing thought:
1. Activate the thought, then click on it or Alt-click on any inactive thought.
2. Type the text for the label in the Label field, then press the Enter key.

When you point at the thought, the label text will appear in a box below the
thought.

Open New Office E"

Phoenix o'

Type Tags E

Figure 121. Label Field in Thought Properties Dialog Box

Swapping a Thought’s Name with its Label

You can swap a thought's name with its label by clicking the Switch button
(double sided arrow) in the Thought Properties dialog box. This can be very
useful when the default label and name are assigned based on a URL and the
automatic naming isn’t optimal for your purposes.
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Figure 122. Swapping Label and Thought Names

Adding an Image to a Thought

In any thought, you can attach an icon from TheBrain’s built-in selection, an
image from a file of your own, an image from notes or attachments in the active
thought, or a screen capture. These pictures provide a visual boost to your brain.
When you point to the icon next to the thought, the picture zooms to a larger size

automatically.

Before mouseover

During mouseover

—— |

(g

-
.

Figure 123. A Thought Icon

To insert an icon from TheBrain’s built-in icon library:

1. Click the thought icon box in the upper left of the Thought Properties box,

then click the Select Stock lcon command.

IT

i

Select Stock Icon (  Ctrl+Alt+]
lag

Choose| Select an icon from the built in set of icons |

Tags

Capture Image
Paste Icon
Copy Icon

Delete Icon

o

Figure 124. Select an Icon from the Built-in Library

2. With the Browse radio button selected, click any of the categories in the left
panel. (See the TheBrain Icons section on page 229 for more about icon
choices.) Click an icon of your choice to add it to the thought. The Thought
Properties dialog box will close automatically when an icon is selected.
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Figure 125. Icon Choices
To insert an image from a file as a thought icon:

1. Click the thought icon box, then click the Choose File command.

T W

MMMMMMM * [Cabel ‘ o

Select Stock Icon Ctrl+Alt+]

Tags

Choose File N

Capture 'mi Choose an image stored on your local machine
Paste Icon

Copy Icon

Delete Icon

Figure 126. Choose a File to Use as an Icon

2. Navigate to the file of your choice, then click the Open button. Supported
file formats for images include .jpg, .png, and .gif.

To create a thought icon from an image in the Content Area:

= Click the image to select it, right-click it, then click the Copy to Icon
command in the context menu.
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Figure 127. Copy to Ilcon Command in the Image’s Context Menu

To create a thought icon from one of its attachments:

= Right-click the attachment, then click the Copy to Icon command in the

context menu.
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Figure 128. Copy to Icon Command in the Attachment’s Context Menu

The new icon will appear to the left of the thought name at the top of the content
area and on the active thought in the plex.
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Figure 129. Thought with its New Icon

To insert a screen capture of an image as a thought icon:

1. Make sure the screen item you want to capture is visible, then activate the
thought and click on it or Alt-click on any inactive thought.

2. Click the thought icon box, then click the Capture Image command.

IT ol

Select Stock Icon Ctrl+Alt+|

Tags

Choose File

Capture Image [ |
‘ Copy an area of the screen and set it as the icon

Paste Icon

Copy Icon

Delete Icon

Figure 130. Capture Something on the Screen to Use as an Icon

3. Your brain will be hidden temporarily and red cross hairs will appear on the
screen. Drag a rectangle around the area to be captured by dragging the
mouse in a diagonal line from one corner of the rectangle to the opposite
corner, then releasing the mouse button.
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Figure 131. Using the Crosshair to Capture an Image

4. When you release the mouse, the image will be in the Icon area of the
Thought Properties dialog box.

Tip: To capture from the Brain window itself, press the Tab key to toggle its
visibility. You will see the crosshairs and you can drag to select the area of your
choice.

While the captured item will become a picture, the source can be anything—a
company logo, a photo, or part of an Excel worksheet or PDF file.

To paste an image you copy from somewhere else:

1. Copy the image using standard techniques. For example, you may right-
click an image on a web page, then click the Copy Image command.

2. After the image is copied, from the Thought Properties dialog box, click
the thought icon box or right-click on a thought in the plex and select the
Paste Icon command.
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Figure 132. Capture Something You’ve Copied to Use as an Icon

To copy an image from the thought to someplace else:

Images you capture can be copied and pasted as attachments, pasted into
notes or the plex, or used as icons.

1. Click the thought icon box, then click the Copy Icon command.
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Delete Icon | Copy the current thought icon l

Figure 133. Copy the Icon to Use Elsewhere

2. The icon you copied can be pasted elsewhere, such as in a thought’s
content area or elsewhere on your computer.

Favicons being displayed as the thought icon can be copied as well.
To change a thought’s icon, repeat the steps above. The icon will be replaced.
To delete a thought’s icon:

= Click the thought icon box, then click the Delete Icon command.
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Select Stock Icon Ctrl+Alt+]
T
Choose File ‘ s

Capture Image

0 Meani'ngoof Life

Paste Icon

Copy Icon

Delete Icon [N

Delete the current thought icon ‘

Figure 134. Removing a Thought Icon

Displaying Inherited Properties

All inherited properties, such as from a thought type’s icon, label or colors, are
displayed in the properties dialog.

Thought types or tags are also clearly indicated.

QTR omsEifon Park
1 = ’

-
Current Focus Phase 2 —

Y T

Figure 135. Properties Dialog Improvements

Making Thoughts Private

Thoughts may be marked “Private.” Private thoughts will appear with a small lock
icon shown below and to the right of the thought. The lock appears whether the
Private thought is active or not. If you make your brain publicly viewable on the
web, private thoughts remain hidden from view by read only visitors. To mark a
thought as “Private,” click the lock icon in the Thought Properties dialog box.
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o What I'm Th'lnk.ing About Now Napping

] Napping - ﬁ
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Figure 136. A Private Thought

Using Thought URLs

Each thought in TheBrain is available via a uniqgue URL. A thought URL can be
used to create links to thoughts from external third-party applications or from
other brains. Thought URLs can also be used within TheBrain as another way to
connect thoughts via links within notes or as attachments to thoughts.

Thought URLSs can be added as hyperlinks in many third-party applications so
that when the link is activated, TheBrain will go to the referenced thought.

To copy athought URL.:

= Right-click the thought (or click the Edit menu), then click the Copy Local
Thought URL command.

Copy “Classic TV*
Copy Local Thought URL |

s

® Copy a link to this thought that will open locally ‘
i - CUpPTCOTe TITOugrTT
M Classic
) Forget "Classic TV" Ctrl+Del

Create Pin

Set as Home Thought

Figure 137. Copying a Thought URL
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To paste a copied thought URL so it will be another thought’s attachment:

1. Activate the thought to which it should be copied (which may be in the

original brain or any active brain), then right-click the thought (or click the
Edit menu).

Click Add Attachment and select the Paste Web Link command. The
URL will be added to the thought as an attachment.

[ ]
oW Aris‘gotle

Lo
OArIStOtgha.“

L )
: ow Aristote...
% Meaning of Life | o ©

Open in New Tab

Open in New Window

Create Child F6

Create Parent F7

Create Jump F8

Set Type >
Set Tags >

Add Attachment > Link to File...

Select Stock lcon Ctrl+Alt+l Link to Folder.

Capture Image Link to URL...

Copy "Meaning of Life" Add Markdown File

Copy Local Thought URL Paste Web Link
Copy Web Thought URL Add frd Paste on Item
Duplicate Thought Add File from Template..

Figure 138. Pasting a Thought URL

To paste athought URL after it has been copied so that it becomes a
hyperlink in a note:

1.

In the note, select the text that will be the link using one of the two methods
below:

= If the text happens to be the name of a thought you want to link to, it will
have a dotted underline—click within the underlined text

= [f the text isn’t the name of a thought, just drag through it to select it

Click the Insert Thought or Web Link command in the content area
toolbar (or right-click and select it from the context menu).

Select the thought in the drop-down list, then click outside of the list to close
it and create the link.

When you click the link, the thought will open and you can click its attachment(s)
to view them in the content area.
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Figure 139. Inserting a Hyperlink in a Note

Pﬁ’@ Thought Types and Tags

If you have several thoughts with which you want to share common attributes,
such as color and an icon, you may want to create a thought type so that these
attributes can be easily applied to many thoughts. This is one use of thought

types.

For example, you may want to create a “person” type for all thoughts that
represent people in your brain. This type might have a label— “Person”—and a
specific color and icon so that all people in your brain stand out and can be easily
recognized.

Type thoughts can be edited by activating them and using the Thought
Properties dialog box, just as you would for any other thought. You can assign
attributes, such as icons, notes, and attachments, to type thoughts.

o® I?riends
@

of Chér Wilson

. . =y
o ¢ Dan Qrown

{ % Bob Jones)

Figure 140. Three “Person” Type Thoughts

Once a type has been applied to a set of thoughts, it can also be used to create
reports of all thoughts of that type.
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When a type has been assigned to a thought, that thought is said to be an
“‘instance” of the type. For example, if you have a thought named “Jane” of the
“Person” type, the Jane thought is said to be an instance of the Person type.
Creating a Thought Type

Thought Types can be created from the Activate Type button in the main
toolbar.

1. Type the new Thought Type name or type multiple new Thought Types
separated with a semicolon

2. Select New Type

@5 Raw(Al A+ @

A Person |Expense

ENew Type 3

New Type

Figure 141. Creating a New Thought Type
To create a thought type from within the plex:

1. Activate the thought you want to be the first instance of the new type, then
click the thought to open its Thought Properties dialog box.

2. Click the Type button, then click the New Type command. Alternatively,
you can right-click the thought, click the Set Type command, then click the
New Type command.

3. Enter the name of the type you want to create, then press the Enter key.
Click outside of the Thought Properties dialog box to close it.

4. If you used the context menu to create the new type, the type will appear as

a thought in the plex. Type thoughts are special and have an oval border
when active and inactive to distinguish them from other thoughts.
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Figure 142. An Active Type Thought (“Person”)
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To do this ... Do this ...
Locate and Enter the Type’s name in the Search box as you would to
Activate a Type search for any other kind of thought, then click the
thought matching result in the drop-down list.
a = A | person (4]
3 matches (] Childward only =

+ Create Jump
Thoughts, Links and Events
N —

™ Personal Finance

& Personal Life

OR

Activate any thought associated with that type, and click
on the Parent thought Type if it is visible.

{PérsorD o Friends
L 2 @

f[>,0‘ Bob Jones] oG

OR

Click the Activate Type button in the menu bar, then click
the type of your choice or begin typing the name of the
type to locate it quickly if the list is long.

ﬁﬂ%Q A Al A+ @

£ Person |

New Type

15% Probability

(25% Probability)

5% Probability,

LNCL Prahkhakhilitv
Delete the active  Click the active Type thought to open its Thought
Type thought Properties dialog box, click the menu button, then click

the Delete thought name command.

Note that unlike normal thoughts, types cannot be
forgotten and remembered. Deleting a type removes it
from your brain permanently.
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To do this ... Do this ...
Set a thought’s Use any of these methods:
Type
= Open the thought's Thought Properties dialog box,
click the Type button, then click the type of your
choice, or
= Right-click the active thought, click the Set Type
command, then click the type of your choice, or
= Click the Thought menu when the thought is active,
click the Set Type command, then click the type of
your choice
= Link the thought as a child of the type
Set a thought’s Click the Set Type button in the Thought Creation dialog
Type during box, then click the type of your choice.

thought creation

Remove a Type
from a thought

Use any of these methods:

= Open the thought’'s Thought Properties dialog box,
click the Type button, then click the Untyped button,
or

= Click on the checked Type to unselect it, or

= Right-click the active thought, click the Set Type
command, then click the Untyped button, or

= Click the Thought menu when the thought is active,
click the Set Type command, then click the Untyped
button

= Unlink the Thought as a child of the type

Create new
thoughts linked
to the active
Type thought

Drag down from the Type thought’s child gate and
continue creating the thought as usual.

Create a Super
Type

Drag up from the parent gate of a Type thought, then
continue creating as usual or link to another existing Type
thought.

Reuse a Type in
another brain

Copy and paste type thoughts from one brain to another
the same way you copy and paste other thoughts.
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Tip: To arrange your display by thought types, right-click on the plex background,
click Arrange Thoughts by, then click Type.

Attributes that are assigned to a thought type are inherited by all instances of
the Type but will be overridden if there are attributes assigned directly to the
thought itself. For example, if you have a thought named “Jane” of the type
“Person,” you can assign an icon of a smiley face to the Person type and it will

/ appear next the Jane thought and all other instances of the Person type. But, if

: you then assign a picture of Jane as the icon for that thought, the picture will

appear on that thought (only) instead of the smiley face. Likewise, a label
assigned to a specific thought would override the label of any thought type
assigned to that thought.

Super Types

TheBrain supports multiple levels of types for advanced modeling. Just like a
thought can have a type, each type may in turn have a super type. To set a super
type, open a thought type that should have the super type, then click the Type
button. The new type will be a parent (or super) type of the active type. The
attributes assigned to a super type are inherited by its sub types and instances.

Super types can be used when there is a category of thoughts which is a subset
of a larger category. For example, the thought type “Person” could be the super
type of the type “Executive.”

/ To see how to find groups of thoughts that share one or more of the same
. Type, please see the Producing Reports section beginning on page 209.

Dynamic Wallpaper

Another advantage of using thought types in your brain is being able to utilize
dynamic wallpaper. This enables you to change the wallpaper of the plex, based
on the type of the current active thought.

To set up a dynamic wallpaper:
1. Navigate to a thought type.
2. Right click and select Set Dynamic Wallpaper

3. Navigate through your machine to locate the desired wallpaper image and
click Open.
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Set Dynamic Wallpaper
v | Visible

Choose an image to display as wallpaper when this thought or its children are activated

Qpen in New Tab

13+ Active Prd Open in New Window
Create Child 6

Create Parent F7

Figure 143. Setting Up Dynamic Wallpaper on a Thought Type

o'« Debbie Miller

{Projects]

/ B Actve Froject

o Project é\lpha
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of¥ P(OJEC.t Beta

pEucES Bet

Figure 144. Navigating to a Thought with a Dynamic Wallpaper assigned to its Type

Navigating to any thought that is associated with a Thought Type containing
Dynamic Wallpaper will fade the current background and transition to the
Thought Type Wallpaper.

Using Thought Tags

If there are multiple attributes you would like to add to your thoughts, you can
create thought Tags. Tags are useful for flagging thoughts that you want to be
able to reference as a group, without them having to share a common parent. For
example, you may want to create a “To do” Tag so you can get a list of all of
these thoughts very quickly.

Tag thoughts can be edited by activating them and using the Thought
’ Properties dialog box, just as you would for any other thought. You can assign
. attributes, such as icons, colored text and colored backgrounds to Tag
thoughts.
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Thoughts can have one or many Tags at the same time. Tag thoughts are global
for a brain and displaying Tag text and icons can be toggled on and off in the
Look & Feel tab of the Preferences window.

' i
® Thought tag
W\_/gﬂ with an icon
# By Bus 4——/
e |

Figure 145. A Thought with a Tag
To create a thought Tag:

1. Activate the thought to which you want to attach a Tag, then click the
thought to open its Thought Properties dialog box.

2. Click the Tags button, then start typing a name for your new Tag.
Alternatively, you can right-click the thought, click the Set Tags command,
then click the New Tag command and start typing a name for your new
Tag. You can also create multiple Tags at the same time by typing a semi-
colon between each Tag name, just as you can do to create multiple
regular thoughts at the same time.

3. Press the Enter key. Click outside of the Tags list to close it, then click
outside of the Thought Properties dialog box to close it. The new Tag will
be attached to the active thought.

"\ . i)
San Francisco E
&
Type Tags =

California Travel

Figure 146. Creating a New Tag

Alternatively, you can right-click the thought or click the Thought menu, click
the Set Tags command, then click the New Tag command and start typing a
name for your new Tag. Press the Enter key when you’ve finished.
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You can also assign one or more Tags to a thought (regular or Type thoughts)
while you're creating the thought by clicking the Tags button in the Thought
Properties or Thought Creation dialog box.

Assigning and Removing Tags

You can assign and remove Tags using the same general technique as for
creating them. The only difference is that instead of typing a new name, you
select (to attach) or deselect (to remove) the Tag name(s) in the list.

As shown below, currently assigned Tags are preceded with a check mark. Click
an assigned Tag to remove it and click any Tag in the list to assign it to the active
thought. This makes it easy to assign and remove multiple Tags at a time.

York
Los Angeles _ IR
INCISCC

) (
=4
d

‘ Type By Bus, California Travel, Tip

]

+ New Tag
v/ (¥ By Bus
v |% California Travel
© Finance
© Phase 2/
vOrip

Figure 147. Assigning and Removing Tags

Assigning Tags to Multiple Thoughts at One Time

If you want to assign Tags to multiple thoughts at once, first select them, then
right-click in the Selection panel. Click the Set Selection Tags command, then
click the New Tag command or on any of the Tag names in the list.

Deleting a Tag

1. Click the Tags button on the toolbar, then click the Tag of your choice to
activate it.
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Lee Sharpe | Classic TV Shows
ﬁﬂ‘kfhm At

£ Personal Lif |
+ New Tag

Best in Class
= By Bu:ﬂ
_() California Traveﬂ
O Favorite)
_@ FundedJ
© Gluton Free
4 HealthyJ
© High Cost
Q Low Cosﬂ
© Medium Cost]
B Ready in 10 Minutes
o
_@ Secure FundingJ

Figure 148. Opening the Tags List

2. Either right-click the thought or click the Thought menu, then click the
Delete “Thought name” command. You can also open its Thought
Properties dialog box, click the menu button, then click the Delete

“Thought Name” command.
To delete multiple Tags at one time:
1. Click the Tags button on the toolbar to display all Tag hames in your brain.

2. Ctrl-click each Tag you want to delete. The Tag is added to the Selection
tab to the left of the list.
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Figure 149. Deleting Multiple Tags List

3. When all the Tags you want to delete are selected, right-click in the
Selection tab, then click the Delete (#) Thoughts command. (Remember
that Tags are also thoughts themselves.)

Unlike normal thoughts, Tags cannot be forgotten and remembered. Deleting a
Tag removes it from your entire brain permanently.

Renaming and Adding Attributes to a Tag

You can change the properties of Tags, just as you change the properties of
regular thoughts—colors, icons, and attachments.

1. Click the Tags button on the toolbar, click the Tag of your choice, then click
the Tag thought to open its Thought Properties dialog box. You can also
click any tag that is visible in the plex to navigate to that tag thought.

2. You can make the same customizations as you can to any thought while
you're in the Tag’s Thought Properties dialog box. When you’re finished
making revisions, press the Enter key.

, Renaming a Tag changes the Tag throughout your entire brain.
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Displaying Thoughts Based on Their Tags

You can show all thoughts with the same Tag by using Search:

= Begin typing the Tag name in the Search box, then click the Tag name when
it appears. Tags may be indicated with any icon that has been assigned to
them. When you click the Tag name in the Search hit list, all thoughts
assigned to that Tag will be displayed in the plex.

Tag Abbreviations

Along with adding icons to Tags and customizing their names with color, you can
also attach an “abbreviation” for the full Tag name. Abbreviated forms of the
name can serve as hints for what the Tags represent while giving the plex a
cleaner appearance.

In the Look & Feel tab of the Preferences window, you can change the Tags
text setting to “Show always” if you want the abbreviations to show. Hovering
: over a thought with Abbreviated Tags or Tag icons will then display the full Tag

name.
@ » Favorite : i |
- Fav
Best in Class E il .
L Ready in 10 Minutes L3 I
= : T FAST
i Gluten Free —
— E L LR Spicy E

(_Tag , Tags |

<[ My Recipes

o Eggalapt Parm cShoy:J Rglmen

¢ ~ Best in Class ©Gluten Free o Best in Class = Fav
o ® Kale Caesar Salad o ® Texas Pete Burritos
? _QGluten Free ) FAST @ Spicy
o® Kung Pao Chicken oThree Bean Chili
©  @Spicy o Best in Class « Fav QGluten Free

Figure 150. Tag Icons and Abbreviations
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Figure 151. Pointing at a Thought Hides the Abbreviation and Shows the Full Name

To enter a

Tag abbreviation:

= |nthe Tag’s Thought Properties dialog box, type the abbreviation in the field

below t

he Tag’s name, then press the Enter key.

' Favorite 3
’. Fav
Tag T Tags E
Figure 152. Creating a Tag Abbreviation
Additional Thought Type and Tag Features

Visible Thought Types and Tags

Types and tags can be visible in the plex. Want to see a type or tag as a child
thought? Just link any existing type or tag thought as a child, or as a jump.

Optionally,

types are visible as parent thoughts as well.

Type thc&;_ht/'ag Top Prioritiesj o3k FamiTy a.nd Fri...

O

ersonale ¢ Weekend Projects|

§ Vacation Planning) ¥~ Tag thought OGaraée Repair

Linkable types and tags eliminate the need to create two thoughts when you

Figure 153. Visible Parent Type and Child Tag

want to show all instances of a type or tag within the plex.
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= Types are visually distinguished by rounded sides.

= Tags are visually distinguished by chamfered (diagonal) corners.
Hiding Visible Thought Types

Thought types being visible in the plex is optional.

= To prevent a thought type from being visible in the plex, right click on a

thought type and uncheck the option for Visible when Parent of Active
Thought

Q TopvPriorities;

|1 Visible when Parent of Active Thought |
Open Toggle whether this type is displayed as a parent of instances ‘
Open in New Window |

Figure 154. Toggling the Visibility of a Thought Type

e This setting can also be modified globally by clicking on File, selecting
Utilities and clicking on Make All Types Visible/Hidden as Parents

Converting Thoughts to Type or Tag

You easily change a normal thought into a type or tag at any time:

= Right-click on a thought and select Convert to Type or Tag

&3 Convert Thought Kind pd

Convert "Weekend Projects” to:

® Type O Tag

Thought types pass on their icon, label, and colors to their
children, making them easy to identify. Thoughts can only have
one parent type. Siblings derived via a parent type are not
displayed to prevent clutter.

These characteristics make using Thought types ideal for broad
types of information that are not related to each other.
Common examples of types include: Person, Crganization and
Country.

| QK | | Cancel

Figure 155. Convert to Type or Tag

= Tags and types can easily be changed into a nhormal thought
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Clickable Tags

Tag icons that show on thoughts are clickable. Click any tag that is visible in the
plex to navigate to that tag thought.

Replacing a Tag

You can easily move a thought through a project cycle or simply re-classify its
tag attributes. To quickly replace a thought’s tag:

»= Right-click on a tag to open its context menu.

= Select the option Replace Tag with and select another tag.

== [ Now
» © Phase 2
P Ready in 10 Minutes
L z | °@ Review
plios Angeles BN il |osio
| Replace Tag with » O Tip
Remove Tag | @ Urgent
Show Tag Properties H’ Vacation Planning D;-

Figure 156. Replacing a Tag

Nested Tags

Tags can be organized under each other so they are easier to organize, navigate
and apply.

= Link two existing tags with a parent/child relationship to sub-categorize

= You may also open a tag’s properties to assign it as a sub category of
another tag

= Nesting can include multiple tags and multiple layers
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Figure 157. Nested Tags

Changing the Properties of a Link

Links between thoughts are normally unnamed. You can name a link by giving it
a “label.” Just like thoughts, links can have Types, notes, and Attachments. You
can control the way they appear in order to clarify relationships or just to create a
more pleasing view of your brain, based on your personal preferences. You can
also manipulate links in order to add or change relationships between your
thoughts.

Just as each thought has its own Thought Properties dialog box, each link has
its own Link Properties dialog box.

To open the Link Properties dialog box, use any of these methods:

Double-click the link, or
Click the link once to select it, then a second time to open the box, or

Alt-click the link (whether or not the link is connected to the active thought),
or

Right-click the link, then click Properties on the context menu, or

Click the link to select it, click the Link menu in the menu bar, then click the
Properties command
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Figure 158. Link Properties Dialog Box
To add a label to a link:

1. Open the Link Properties dialog box for the link, then type a label name in
the Label field.

lPiano ]E
l_ Default lo meOne-wayv
; -
= : " Piano- ,
0
ol ﬁla%ing

Figure 159. Adding a Label to a Link

2. Press the Enter key, or click outside of the Link Properties dialog box to
close it. The label will appear on the link and will be enlarged when the
mouse points at the link.

To change the color of a link:
1. Open the Link Properties dialog box for the link, then click the color box.

2. Click the color of your choice in the color palette, click outside of the palette
to close it, then press the Enter key, or click outside of the Link Properties
dialog box to close it.

TheBrain 13 User Guide 134



Customizing Thought and Link Properties

o 2 Hobbies i]

Original color —4, | Defalt | © CJonewa
0 l-?obbies

<€[] What I'm R New color —4,

¢”] What I'm Readir

Custom Default

. Custom . Default

Figure 160. Changing the Color of a Link

, This changes the color for the individual link. You can set link colors globally in
. the Brain Theme box (please see the Customizing a Theme’s Colors section
on page 41 for details).

To change the width of a link:

= Open the Link Properties dialog box for the link, click the Default button,
click the width of your choice, then click outside of the Link Properties dialog
box to close it.

Ka

o ® Texas [ete Burritos * Ku

] Shq
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"l 05
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Figure 161. Changing the Width of a Link
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/ Tip: You might want to widen links to illustrate the strength of particular
relationships between thoughts.

®
PH’@ Link Types

Link types are used to assign commonly-used relationships between thoughts
that share a label, color, and width so they can be easily recognized. Link
properties and types will be retained even if the two linked thoughts change their
relationship but remain linked (for example, if a child thought becomes a jump
thought of the original thought).

In addition to setting their color, you can add labels to link types and you can
change the width of the link to call special attention to relationships.

1. Open the Link Properties dialog box for the link, then click the Type
button.

This button will display “Untyped” if there is currently no Type assigned to the
link and it will display the type name if there is already a Type assigned.

2. If there’s an existing Type in the list that you want to use, click on it to
select it. Otherwise, click on New Type, then type the name for the new link
in the field that will be displayed.
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Figure 162. Creating a New Link Type

2. Press the Enter key to close the Link Properties dialog box.

